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REFERENCES

CONVENTIONS
This manual uses the following conventions:

"User" refers to anyone using a Matrix 210™ reader.

"Reader" refers to the Matrix 210™ reader.

"You" refers to the System Administrator or Technical Support person using this manual to
install, configure, operate, maintain or troubleshoot a Matrix 210™ reader.

REFERENCE DOCUMENTATION

For further details refer to: the VisiSet™ Help On Line, Matrix Reading Methods, Matrix Host
Mode Programming, Matrix SW Parameter Guide, Matrix Code Quality Verifier Solution
provided as supplementary documentation on the VisiSet™ mini-DVD (downloaded ISO file
or mini-DVD accessory).

SUPPORT THROUGH THE WEBSITE

Datalogic provides several services as well as technical support through its website. Log on
to www.datalogic.com and click on the Industrial Automation links for further information:

e PRODUCTS - FIXED INDUSTRIAL BARCODE READERS

Select your product from the links on the Fixed Industrial Barcode Readers page. The
product page describes specific Info, Features, Applications, Models, Accessories, and
Downloads including documentation, software drivers, and the VisiSet™ utility program,
which allows device configuration using a PC through Serial and Ethernet interfaces.

e SUPPORT & SERVICES - INDUSTRIAL AUTOMATION

Several links from the Industrial Automation list take you to additional services such as:
Service Program which contains Maintenance Agreements and Warranty Extensions;
Repair Centers; On-Line RMA Return Material Authorizations; Technical Support through
email or phone, Downloads for additional downloads.

PATENTS

See www.patents.datalogic.com for patent list.

This product may be covered by one or more of the following patents:

Utility patents: EP0996284B1, EP0999514B1, EP1014292B1, EP1128315B1,
EP1396811B1, EP1413971B1, EP1804089B1, EP2315156B1, JP4435343B2,
JP4571258B2, JP5192390B2, US6512218, US6616039, US6808114, US6997385,
US7053954, US7387246, US8058600, US8113430, US8368000, ZL200680050007.8

Vi


http://www.patents.datalogic.com/

COMPLIANCE

For installation, use and maintenance it is not necessary to open the reader.

Only connect Ethernet and dataport connections to a network which has routing only within
the plant or building and no routing outside the plant or building.

EMC COMPLIANCE

In order to meet the EMC requirements:

e connect reader chassis to the plant earth ground by means of a flat copper braid shorter
than 100 mm

e connect pin "Earth" of the CBX connection box to a good Earth Ground

POWER SUPPLY
ATTENTION: READ THIS INFORMATION BEFORE INSTALLING THE PRODUCT

This product is intended to be installed by Qualified Personnel only.

This product is intended to be connected to a UL Listed Computer (LPS or "Class 2") which
supplies power directly to the reader or a UL Listed Direct Plug-in Power Unit (rated 10 to
30 V, minimum 500 mA) marked LPS or “Class 2”.

CE COMPLIANCE

Warning: This is a Class A product. In a domestic environment this product may cause radio
interference in which case the user may be required to take adequate measures.

FCC COMPLIANCE

Modifications or changes to this equipment without the expressed written approval of Datalogic could
void the authority to use the equipment.

This device complies with PART 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference which may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case
the user will be required to correct the interference at his own expense.

LED SAFETY

LED emission according to EN 62471

Vii



HANDLING

The Matrix 210™ is designed to be used in an industrial environment and is built to withstand
vibration and shock when correctly installed, however it is also a precision product and
therefore before and during installation it must be handled correctly to avoid damage.

e avoid that the readers are dropped (exceeding shock limits).

¢ do not fine tune the positioning by striking the reader or bracket.

W
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do not weld the reader into position which can cause electrostatic, heat or reading
window damage.

do not spray paint near the reader which can cause reading window damage.

Ko




GENERAL VIEW

Matrix 210™

Figure A
@ Device Class Labels @ Ethernet Connector
@ Power On LED @ Ethernet Connection LED
(for Ethernet Models)
@ Power — Serial — /10 HMI X-PRESS™ Interface
Cable Connector

@ Reading Window

Internal llluminator
Good Read LED Spot (green)

Mounting Holes (4)

®OE
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1 RAPID CONFIGURATION

STEP 1 - CONNECT THE SYSTEM

25-Pin Models

To connect the system in a Stand Alone configuration, you need the hardware indicated in
Figure 1. In this layout the data is transmitted to the Host on the main serial interface. Data
can also be transmitted on the RS232 auxiliary interface independently from the main
interface selection.

When One Shot or Phase Mode Operating mode is used, the reader is activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

PG 6000

[ oo -
a | A
Matrix 210™ S em R | -ty
Host
I- i * External Trigger or Presence Sensor
[ ] p.s.* 1/0, AUX (for One Shot or Phase Mode)

Figure 1 — Matrix 210™ in Stand Alone Layout
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CBX100/CBX500 Pinout for Matrix 210™ 25-Pin Models

The table below gives the pinout of the CBX100/CBX500 terminal block connectors. Use this
pinout when the Matrix 210™ reader is connected by means of the CBX100/CBX500:

CBX100/500 Terminal Block Connectors
Input Power Outputs
Vdc Power Supply Input Voltage + +V Power Source - Outputs
GND | Power Supply Input Voltage - -V Power Reference - Outputs
Earth | Protection Earth Ground Ol+ Output 1 +
O1- Output 1 -
Inputs 02+ Output 2 +
+V Power Source — External Trigger 02- Output 2 -
1A External Trigger A (polarity insensitive) Auxiliary Interface
1B External Trigger B (polarity insensitive) TX Auxiliary Interface TX
-V Power Reference — External Trigger RX Auxiliary Interface RX
+V Power Source — Inputs SGND | Auxiliary Interface Reference
I2A Input 2 A (polarity insensitive) ID-NET™
12B Input 2 B (polarity insensitive) REF Network Reference
-V Power Reference — Inputs ID+ ID-NET™ network +
Shield ID- ID-NET™ network -
Shield | Network Cable Shield
Main Interface
RS232 RS485 Full-Duplex RS485 Half-Duplex
TX TX+ RTX+
RTS TX- RTX-
RX *RX+
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.

ground references. GND, SGND and REF are internally connected through
filtering circuitry which can be permanently damaged if subjected to voltage
drops over 0.8 Vdc.

i CAUTION: Do not connect GND, SGND and REF to different (external)
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USB Models

NOTE: Before connecting the reader to the USB Port, Install the USB Virtual
COM Port Driver from the VisiSet™ mini-DVD (downloaded ISO file or mini-
DVD accessory) in the Support Files\Software Utilities\USB Virtual COM Port
Drivers directory.

The USB Virtual COM Port Driver allows sending serial data using the Matrix 210™ USB
port. A different virtual COM Port will be assigned to each connected reader.

Installing the USB Virtual COM port drivers:

1. Double-click on the following file to launch the USB Virtual COM Port Driver Installer.
Windows XP/Vista/7 (x32) = "DPInst.exe" Windows Vista/7 (x64) = "DPInstx64.exe"
For other operating systems see the readme txt in the Support Files\Software Utilities\USB

Virtual COM Port Drivers directory. For updated drivers or more details go to
ftdichip.com/Drivers/VCP.htm.

Configuring the USB Virtual COM port:

Connect the Matrix 210™ USB reader to your PC; a new virtual COM port is associated with
the reader. Follow these steps to configure the associated COM Port:

Right-click on "My Computer" in the Windows "Start" menu and select "Properties".

Select the "Hardware" tab in the System Properties dialog and click the "Device
Manager" button.

4. Expand the "Ports (COM & LPT)" item on the "Device Manager" menu. Right-click on
"USB Serial Port" and select "Properties”.

5. Select the "Port Settings" tab in the "Properties" dialog and click the "Advanced" button.
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6. From the "Advanced Settings for COMx" dialog:

e Expand the "COM Port Number" menu and select a new COM Port number if
desired (optional).

e Set the "BM Options" -> "Latency Timer" (msec) parameter to 1.

Advanced Settings for COM2 @@

COM Port Number: | cop2 |

oK

USE Transfer Sizes _
Cancel

Select lower settings to correct performance problems at low baud rates.
Select higher settings for faster performance.

Receive (Bytes): 4Uéé v
Transmit (Bytes): 4Uéé v |
BM Dptions Miscellaneous Options
Select lower settings to correct response problems. Serial Enumerator
. g — Serial Printer |
Latency Timer [msec): 1 v |
\ : Cancel If Power Off |
Timeouts Event On Surprise Removal |
’ ) SetRTS On Close |
Miniroum Read Timeout (msec) 07 Vi Disable Modem Ctrl &t Statup — []
Minimum YWrite Timeout (msec): | 'U v ‘

You are now ready to use the new COM Port.

Matrix 210™ USB models can be connected in a Point-to-Point layout to a local host through
their USB cable. No external power supply is necessary.

Matrix 210™ =

uuuuu

L 1

Figure 2 — Matrix 210™ USB Model in a Point-to-Point Layout
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STEP 2 — MOUNT AND POSITION THE READER

1. To mount the Matrix 210™, use the mounting brackets to obtain the most suitable
position for the reader. Two of the most common mounting configurations are shown in
the figures below. Other mounting solutions are provided in par. 3.3.

CE> Tilt

E; Tilt

Figure 3 —Positioning 90° and Straight Model with Mounting Bracket

NOTE: For applications where strong vibration or continuous bumps are
present, it is recommended to use a double mounting bracket solution.

2. When mounting the Matrix 210™ take into consideration these three ideal label position
angles: Pitch or Skew 10° to 20° and Tilt 0°, although the reader can read a code at any tilt

angle.
\
%’ I \-
S — S

‘ Assure at least 10° ‘ Minimize ‘ Minimize

Figure 4 — Pitch, Skew and Tilt Angles

o

3. Refer to the Reading Features table in chp. 6 to determine the distance your reader
should be positioned at.

NOTE: Rapid Configuration of the Matrix 210™ reader can be made either
through the X-PRESS™ interface (steps 3-4) which requires no PC
connection, or by using the VisiSet™ Setup Wizard (steps 5-6). Select the
procedure according to your needs.
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STEP 3 - AIM THE READER

Matrix 210™ provides a built-in aiming system to aid reader positioning. The aiming system
is accessed through the X-PRESS™ Interface.

1. Power the reader on. During the reader startup (reset or restart phase), all the LEDs blink
for one second. On the connector side of the reader near the cable, the “POWER ON”
LED (blue) indicates the reader is correctly powered.

2. Enter the Aim/Locate function by pressing and holding the X-PRESS™ push button until
the Aim LED is on.

3. Release the button to enter the Aim function. The aiming system turns on see Figure 5.

Place the application specific code in front of the reader at the reading distance
indicated for your model in the Reading Features Fixed Focus table in par.Error!
Reference source not found., centering it in the aiming system indicator.

default value for: Fov

NEAR, MEDIUM,

FAR models HEA{_)Ym
GOOD

TRIGGER

<.'m

press

inter face

default value for:
UHD models

e
X
A

¥
ETETET

o
s
e

4

]
]

3!
o

o
"

2
e
2

sng‘a‘Tus A
2

e
e
)

2
iy
&
)
byttt
5

ik &
B e

it s

o
25
et
&

7
5

¥

&

Figure 5 - Aiming Function Using The Blue Ring or  Figure 6 — X-PRESS™ Interface: Aim Function
Internal Lighting System *

* the default value of the Aiming System Status parameter can be changed in VisiSet™.

5. Exit the Aim function by pressing the X-PRESS™ push button once. The aiming system
turns off.
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STEP 4 — X-PRESS™ CONFIGURATION

Once Matrix 210™ is positioned with respect to the code (step 3), you must configure it for
optimal code reading relative to your application. This configuration can be performed either
through the X-PRESS™ Interface or the VisiSet™ configuration program.

Setup

1. Enter the Setup function by pressing and holding

the X-PRESS™ push button until the Setup LED is
on.

Release the button to enter the Setup function.
The Setup LED will blink until the procedure is
completed.

The Setup procedure ends when the Image
Acquisition parameters are successfully saved in
the reader memory, the Setup LED will stop
blinking and Matrix 210™ emits 3 high pitched
beeps.

If the calibration cannot be reached after a timeout
of about 5 (five) seconds Matrix 210™ will exit
without saving the parameters to memory, the
Setup LED will stop blinking and in this case Matrix
210™ emits a long low pitched beep.

Learn

3. Enter the Learn function by pressing and holding

the X-PRESS™ push button until the Learn LED is
on.

Release the button to enter the Learn function.
The Learn LED will blink until the procedure is
completed.

The Learn procedure ends when the Image
Processing and Decoding parameters are
successfully saved in the reader memory, the
Green Spot is activated, the Learn LED will stop
blinking and Matrix 210™ emits 3 high pitched
beeps®.

If the autolearning cannot be reached after a
timeout of about 3 (three) minutes Matrix 210™ will
exit without saving the parameters to memory, the
Learn LED will stop blinking and in this case Matrix
210™ emits a long low pitched beep.

cancelled.

! The Learn procedure will not recognize Pharmacode symbologies.

READY

GOOD
06D

TRIGGER

press

‘ inter face

o@D
cou
D

sTatUs &
@

v
-

]

Figure 7 — X-PRESS™ Interface: Setup
Function

READY
C DD
000
0D

TRIGGER

com

*D

STATUS A
oR

‘DI’EES
inter face

-
-

J

Figure 8 — X-PRESS™ Interface: Learn
Function

NOTE: You can exit the Learn function at any time by pressing the
X-PRESS™ push button once. After a short delay the Learn procedure is
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NOTE: If you have used this procedure to configure Matrix 210™ go to step
7.

RESET READER TO FACTORY DEFAULT (OPTIONAL)

If it ever becomes necessary to reset the reader to the factory default values, you can
perform this procedure by holding the X-PRESS™ push button pressed while powering up
the reader. You must keep the X-PRESS™ push button pressed until the power up
sequence is completed (several seconds) and all LEDs blink simultaneously 3 times.

All LEDs remain on for about 1 second, then off for one second, the Configuration and
Environmental parameters are reset, and the status LED remains on. If connected through a
CBX500 with display module, the message "Default Set" is shown on the display.
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STEP 5 = INSTALLING VISISET™ CONFIGURATION PROGRAM

VisiSet™ is a Datalogic reader configuration tool providing several important advantages:

e Setup Wizard for rapid configuration and new users;

¢ Defined configuration directly stored in the reader;

e Communication protocol independent from the physical interface allowing to consider the
reader as a remote object to be configured and monitored.

To install VisiSet™, turn on the PC that will be used for the configuration, running
Windows 98, 2000/NT, XP, Vista, 7 or 8. Then run the VisiSet™ installation program
(Setup.exe) from the VisiSet™ Mini-DVD (downloaded I1SO file or mini-DVD accessory),
and follow the installation procedure.

This configuration procedure assumes a laptop computer, running VisiSet™, is connected to
the reader's auxiliary port.

After installing and running the VisiSet™ software program the following window:

ions  Tools Help

Press <Connect> to configure the reatle.r.}

[Connection: none. Reader Status: NOT CONNECTED Log : OFF

Figure 9 - VisiSet™ Opening Window
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Set the communication parameters from the "Options" menu. Then select "Connect", the
following window appears:

10

H visiset rel. 6.62

File Edit Connect Disconnect Device Options Tools Help

MAIN MENU

Device: Matrix 210

M. Setup Wizard Model: 215-111
Communication Port: Ethernet
F. Calibration Tool

Standard Application Program for Matrix Family Rel. 6.62

MACHW: 00:
DHCP disabled
IP Address: 172.27.101.226
Subnet Mas! 55.255.0.0
Gateway: 172.24.255.254
DHS1: 19 1

C. Decode Last Image

E:00:E4:48

Connection: B14P00304 on 172,27.101.226 Reader Status: OFF LINE MODE

EEX

Log : OFF

Figure 10 - VisiSet™ Main Window After Connection
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STEP 6 — CONFIGURATION USING SETUP WIZARD

The Setup Wizard option is advised for rapid configuration or for new users. It allows reader
configuration in a few easy steps.

1. Select the Setup Wizard button from the Main menu.

1) Setup Wizard jm] ;] | B Setup Wizard [Z]\EHX\
Top.Left
1. Positioning Send Defaults
Calibration Mode
2. Calibration " Change Exposure Time And Gain (Static Mode)

€ Change Gain Only

Capture Image Code Setting Mode
3. Code Setiing @ Add New Symbology
. Co— " Replace Current Symbologies
Bottom Right —I Saving Options
Image Acquisition Information " Pemmanent Memory
Acquisition Setting: " Temporary Memory
Setup Result
Decoding Results
Symbolagy: Selected Code: I j
Code Data:
Code Center:
Image Lighting Quality
TX/RX
J Close

Place the application specific code in front of the reader at the correct reading distance
(see step 2 and the Reading Features table in the chp. 6).

2. Press the "Positioning" button. The reader continuously acquires images and gives visual
feedback in the view image window. The Setup Wizard now shows four delimiters (red
points) in the acquired images which indicate the region in which the calibration algorithm
is active. Move the reader (or code) to center it.

Press the Positioning button again to stop positioning.

11
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@ Setup Wizard
Top.Left

Image &cquisition Information
Acquisition Setting: 1
Exposure Time (x10us): 400
Gain:

- Décoding Results
Symbology:

Code Data:

Code Center:

[~ Image Lighting Quality

Download image
Bottom,Right —I

Disabled

Self Tuning:

Selected Code:

=

TR/RX

= Close

@ Setup Wizard

~Calibration Mode -
@ Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Code Setting Mode
¢ Add New Symbology
" Replace Current Symbologies

Saving Options
" Permanent Memory
& Temporary Memary

Setup Result

3. Select a Calibration Mode choice and press the "Calibrate" button. The reader flashes
once acquiring the image and auto determines the best exposure and gain settings. If the

code symbology is enabled by default, the code will also be decoded.

EB Setup Wizard

Top Left

~Image &cquisition Information

Acquisition Setting: 1
Exposure Time (x10us): 160
Gain:
V'Decoding Results
Symbology:
Code Data:
Code Center:

Image Lighting Quality
Exposure Index:

Undererposed ¢

Overexposed

Capture Image
View Image
Download Image
Bottom Right

Enabled
Completed

Self Tuning:
Status:

Selected Code:

Lighting Index:

“TRRX

i Close

:I3 2. Calibration

EB Setup Wizard

1. Positioning

Send Defaults

~Calibration Mode
' Change Exposure Time And Gain (Static Mode)
" Change Gain Only

[ Code Setting Mode:
& Add New Symbology
" Replace Current Symbologies

3. Code Setting

Saving Options
" Permanent Memory

4. Save

~Setup Result

& Temporary Memory

Calibration procedure in progress ...

Calibration procedure completed using Image Acquisition
Setting #1.
New Exposure Time (x1lOus):
New Gain

160
H I

12
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4. Select a Code Setting Mode choice and press the "Code Setting" button.

The Setup Result section of the Setup Wizard window shows the code type results and
the parameter settings.

EHSetup Wizard llE=1] EHSetup Wizard

Top.Left
1. Positioning Send Defaults

Calibration Mode:

2. Calibration ' Change Exposure Time And Gain (Static Mode)
" Change Gain Only

Capture Image I ~Code Setting Mode-
| 4 3. Code Setting @ Add New Symbology
I

View Image

y Download Image
. : Bottom Right Saving Options
Image. li«.:qulsllm.n Informatior i ) 4 Save " Permanent Memory
Acquisition Setting: 1 Self Tuning: Disabled

& Temporary Memory

" Replace Current Symbologies

Exposure Time (x10us): 160
e 12 Setup Result
Decoding Results ~ &
Symbology: Data Matiix ECC 200 Selected Code: T4 Fade Secting’ proceduze;in proyress: =y
Code Data: Datalogic 2D Code Reader Code Setting procedure completed: 1 code{s) found.
Code Center: (X.Y)=(372,241) Code Symbologies:
S i . 1. Data Matrix ECC 200
SRt ST & gl | Processing Mode : Advanced Code Setting I
Image Lighting Quality Rectangular Formats : Disabled Setup ReSUt
Data Matrix Module Size: 1l mils
Exposure Index: Lighting Index: Code Color : Black
Underexposed ok Overexposed Inage Mirroring : Disabled
Code Contrast (2D) : Standard
TR/RX Decoding Method : Standard .
™
_J Close =

5. Select a Saving Options choice and press the "Save" button.

@ Setup Wizard

1. Positioning Send Defaults

Calibration Mode

2. Calibration ' Change Exposure Time And Gain [Static Mode)
" Change Gain Only

- Code Setting Mode

3. Code Setiing & Add New Symbology

" Replace Current Symbologies

Saving Options

4 ' Permanent Memory o

€ Temporary Memary

“Setp resun

Code Setting procedure completed: 1 code(s) found. &
Code Symbologies:
1. Data Matrix ECC 200

Processing Mode : Advanced Code Setting
Rectangular Formats : Disabled

Data Matrix Module Size: 11 mils

Code Color : Black

Inage Mirroring : Disabled

Code Contrast (2D) : Standard

Decoding Method : Standard

Checking configuration...OK
Configuration saved in Permanent memory'

%

6. Close the Setup Wizard.

NOTE: If your application has been configured using the VisiSet™ Setup
Wizard, your reader is ready. If necessary you can use VisiSet™ for
advanced reader configuration.
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STEP 7 - TEST MODE

Use a code suitable to your application to test the reading performance of the system.
Alternatively, you can use the Datalogic 1D/2D Test Chart (Code 39, Data Matrix ECC 200).

1. Enter the Test function by pressing and holding the X-PRESS™ push button until the

Test LED is on.

2. Release the button to enter the Test function.

Once entered, the Bar Graph on the five LEDs is activated and if the reader starts
reading codes the Bar-Graph shows the Good Read Rate. In case of no read condition,
only the STATUS LED is on and blinks.

évrgrus A

READY

GOOD

TRIGGER

‘DI—ESS
interface

-
A

)

Figure 11 — X-PRESS™ Interface: Test Function

3. To exit the Test, press the X-PRESS™ push button once.

NOTE: By default, the Test exits automatically after three minutes.

The Bar Graph has the following meaning:

2> 95%

> 75%

2 60%

2> 40%

> 20%

READY

GOOD

TRIGGER

STATUS A
@

Figure 12 — Test Bar Graph
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ADVANCED READER CONFIGURATION

For further details on advanced product configuration, refer to the VisiSet™ Help On-Line.
The following are alternative or advanced reader configuration methods:

Advanced Configuration Using VisiSet™

Advanced configuration can be performed through the VisiSet™ program by selecting
Device> Get Configuration From Temporary Memory to open the Parameter Setup window in
off-line mode. Advanced configuration is addressed to expert users being able to complete a
detailed reader configuration. The desired parameters can be defined in the various folders
of the Parameter Setup window and then sent to the reader memory (either Temporary or
Permanent):

File Edit Connect Disconnect Device Options Tools Help

T
MAIN MENU H Parameter Setup

Device: Matrix [FEEENCENIMGES

M. Setup Wizard Model: 211-100 =
[TONNSPRE]  Got | Send | SendDefaults | | Permanent || Interactive |
F. Calibration Tool

RTTCITT W IOSEe] 20 Codes | 1D Codes | PostalCodes | ImageProcessing | Miscellaneous |
Reading SystemLayout |  CBXGateway | Display | Diagnostics |

V. Symbol Verification
OperatingModes | Caliration | Digitall/0 |  LEDsAndKeypad
A. Run Mode Data Collection |  Match Code | Symbol Veriication |  Communication
B. Capture Image CODE COLLECTION
Number Of Codes 1
L Decotalasd Mnaite Code Colection Filers Disabled
D. View Last Image DATA FORMAT
Code Field Justificati Disabled
E. Download Last Image s il O ieabe
Code Field Cutting Disabled
H. Upload Bitmap Image [ No Read Message <245
6. Store Match Code Data Packet Format %2%
Statistics Field Separator String <I<10>
0. Image Buffer [ Statitics Field Format %1
3. Button Function Menu Siobasidonifiers Disabied

Disabled

Status

Connection: CO8D1200S on COM1 at 115200,N,8,1 Reader Status: OFF LINE MODE Log : OFF

Figure 13 - VisiSet™ Parameter Setup Window

Host Mode Programming

The reader can also be configured from a host computer using the Host Mode programming
procedure, by commands via the serial interface. See the Host Mode Programming file from
the Start menu (Start>All Programs>Datalogic>VisiSet>Support Files>Host Mode
Programming).

Alternative Layouts

If you need to install an Ethernet network, ID-NET™ network, Fieldbus network, Pass-
Through network, refer to chapter 5.

The reader can also be setup for alternative layouts by reading programming barcodes. See
the "Setup Procedure Using Programming Barcodes" printable from the VisiSet™ Mini-DVD
(downloaded ISO file or mini-DVD accessory).

Code Quality Verification

Matrix 210™ can be used as a Code Quality Verifier according to the ISO/IEC 15415,
ISO/IEC 15416, AS9132, and AIM DPM Standards.

15
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2 INTRODUCTION

2.1 PRODUCT DESCRIPTION

Matrix 210™ is the new Datalogic 2D reader offering excellent reading performance, ultra
compact size and extreme ease of use. Thanks to innovative optical features, advanced
software functions and complete connectivity options, Matrix 210™ is the cost effective
solution for applications where the space is very limited.

Ultra Compact Size
Compact dimensions, straight and 90° reading window models availability allow flexible
mounting and positioning in narrow spaces.

Excellent Reading Performance

WVGA image sensor, up to 60 frames/s acquisition rate and dynamic reading capability,
together with powerful decoding libraries provide excellent performance on a wide range of
code symbologies as well as damaged and low quality codes. Matrix 210™ allows reading
10 mils codes in moving applications at speeds up to 2 m/sec.

Innovative Optical Features

The innovative optical and lighting systems ensure wide field of view at short reading
distances, combined with excellent illumination pattern. Matrix 210™ has a maximum
reading distance of 200 mm, and it can read at near distance ultra high density 2D codes up
to 0.076 mm (3 mils).

Ease Of Use

The intuitive X-PRESS™ Human Machine Interface makes installation and maintenance
easier than ever thanks to a five LED bar graph and the multi-function key providing
immediate access to relevant functions such as Aiming, Setup (for automatic imager
calibration), Learn (for automatic code setting), Test Mode (for bar graph activation). A Green
Spot provides immediate Good Read feedback.

Enhanced Connectivity
An embedded high speed ID-NET™ communication interface allows efficient data collection
and simplifies network wiring. USB interface models allow direct connection to a PC.

Industrial Features
Matrix 210™  with its rugged construction, IP65 protection class, 50°C max operating
temperature and 10 to 30 VDC power supply is the ideal product for industrial applications.
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Matrix 210™ has been developed for use in numerous industries like:

Electronics:
= PCB Board Tracking
= Electronics Product Tracking

Pharmaceutical & Chemical:
= Medical Devices Traceability
= Pharmaceutical and Medicine Manufacturing

OEM:

= Chemical & Biomedical Analysis Machines
Access Control Systems

Self Service Systems (ATM, Kiosks)

Print & Apply systems

Document Handling

This technology intrinsically provides omni-directional reading.

Standard Application Program

A Standard Application Program is factory-loaded onto Matrix 210™. This program controls
code reading, data formatting, Ethernet interfacing, serial port and USB interfacing, and
many other operating and control parameters. It is completely user configurable from a
Laptop or PC using the dedicated configuration software program VisiSet™, provided on the
VisiSet™ Mini-DVD (downloaded ISO file or mini-DVD accessory).

There are different programmable operating modes to suit various code reading system
requirements.

Quick, automatic positioning, calibration and code setting of the imager can be accomplished
using the X-PRESS™ button and LEDs on top of the reader without the necessity of a PC.

The previous functions can also be performed through VisiSet™ through the Setup Wizard.
This tool includes visual feedback from the reader.

VisiSet™ provides a Calibration Tool to verify the exact positioning of the reader and to
maximize its reading performance.

Statistics on the reading performance can also be visualized through a dedicated window in
VisiSet™.

Symbol Verification can be performed through VisiSet™ when the reader has been installed
and setup as a Verifier station.

Programmability

If your requirements are not met by the Standard Application Program, Custom Application
Programs can be requested at your local Datalogic distributor.

17
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Some of the main features of this reader are given below:
e Ultra Compact Dimensions

e Direct and 90° window models for smart mounting

¢ Qutstanding decoding capability on 1D, 2D, Stacked and Postal symbologies
e High performance on dynamic reading applications

e X-PRESS™ for easy and intuitive setup

e Optical Aiming System

e 10to 30 VDC Power Supply

¢ High Speed Ethernet Connectivity

e USB Connectivity

e |ID-NET™ embedded high speed connectivity

e Region Of Interest Windowing for higher frame rate

¢ Run Time Self Tuning for higher flexibility

18



INTRODUCTION o

2.2 INDICATORS AND KEYPAD BUTTON

@ Figure 14 - Indicators

The following LED indicators are located on the reader:

NET For Ethernet models, on the connector side of the reader near the Ethernet
connector, the orange ETHERNET NETWORK PRESENCE LED indicates the
on-board Ethernet network connection. (Figure 14, 1)

PWR On the connector side of the reader near the cable, the blue POWER ON LED

indicates the reader is correctly powered. (Figure 14, 2)

In normal operating mode the colors and meaning of the five LEDs are illustrated in the

following table:

READY green LED indicates that the reader is ready to operate (Figure 14, 3)

GOOD green LED confirms successful reading (Figure 14, 4)

TRIGGER |yellow LED indicates the status of the reading phase (Figure 14, 5)

COM yellow LED indicates active communication on the main serial port * (Figure 14, 6)
STATUS red LED indicates a NO READ result (Figure 14, 7)

* When connected to a Fieldbus network through the CBX500, the COM LED is always active, even in the
absence of data transmission, because of polling activity on the Fieldbus network.

During the reader startup (reset or restart phase), these five LEDs blink for one second.

In X-PRESS™ Configuration mode the colors and meaning of these five LEDs are described

in par. 2.4.

The keypad button (Figure 14, 8, is software programmable. By default it starts the X-
PRESS™ interface for quick installation without using a PC (see chp. 1).
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2.3 ID-NET™

The ID-NET™ network is a built-in high-speed interface dedicated ™
for high-speed reader interconnection. ID-NET™ is in addition to
the Main and Auxiliary serial interfaces. ID NET

The following network configurations are available:

= |D-NET™ M/S Synchronized: Single station — multiple readers

CBX100 CBX100

ID NET"

ID-NET™ interface allows local connection of multiple readers reading different sides of the
same target. All readers share a single presence sensor and activate/deactivate
simultaneously.

At the end of each reading phase a single data message is transmitted to the host.

Thanks to ID-NET™, data communication among readers is highly efficient so that an
immediate result will be available.

20
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= |ID-NET™ M/S Multidata: Multiple stations — single reader

/‘/\W/ /'lJ’ /;]"

CBX100 CBX100

ID NET"

ID-NET™ interface allows connection of readers reading objects placed on independent
conveyors. All readers are typically located far away from each other and they use a
dedicated presence sensor.

At the end of each reading phase, each reader transmits its own data message to the host.
Thanks to ID-NET™, data collection among readers is accomplished at a high speed without
the need of an external multiplexing device. This leads to an overall cost reduction and to a
simple system wiring.

2.3.1 How To Setup/Configure the Reader Network

A complete ID-NET™ reader network can be easily setup through VisiSet™ as follows:

Mounting & Connection

1. Mechanically mount/install all the readers (refer to par. 3.2 and 3.3).
2. Wire ID-NET™ (refer to par. 4.3 or Error! Reference source not found.).

3. Power up the entire system.

Confiquration of Slaves

1. Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Slave reader.

Launch VisiSet™ and connect to the Slave reader.
From the VisiSet™ Device Menu select "Parameter Setup".

Set the Role of the Slave reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

5. Set the Slave Address according to the desired value 1-31 from the
Reading System Layout > Device Network Setting > Slave Address parameter. Each
reader must have a different Address on the ID-NET™ Network.

6. If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).
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7.

8.

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Slave device is now Configured. Physically connect it to the Master/Slave network. If
using the CBX connection box equipped with a BM100 Backup module, you can perform
Device Backup at the Slave (see par. 2.4 for details).

Repeat these steps for each Slave reader in the ID-NET™ network.

Confiquration of Master

1.

Connect a PC equipped with VisiSet™ to the Main, Auxiliary or Ethernet interface of the
planned Master reader.

Launch VisiSet™ and connect to the Master reader.
From the VisiSet™ Device Menu select "Parameter Setup”.

Set the Role of the Master reader (Synchronized or Multidata) from the
Reading System Layout > Device Network Setting > Topology Role parameter.

Enable the planned Slave device N from the Reading System Layout >
Expected Slave Device #N > Status parameter and, if desired, set the related
identification string from the Expected Slave Device #N > Device Description parameter.
Repeat this step for all planned Slave devices.

If necessary, set the ID-NET™ baudrate from the Reading System Layout >
Device Network Setting > Network Baud Rate parameter, (500 kbs default).

Configure the other device parameters via VisiSet™ [Operating Mode, Calibration, Data
Collection parameters, etc.].

The Master device is now Configured. Physically connect it to the Master/Slave network.
If using the CBX connection box equipped with a BM100 Backup module, perform a
Network Backup at the Master (see par. 2.4 for details).

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices
within the ID-NET™ network.

[S!oo Devices Network Scschng] Backup ol Network ’
(Skwe We:: [Rm.kcd §luu.[6wm Status lf}hicbc:cw Is«u Hunbﬁ ]Pa.)‘ndc; [ -~
-Enabled Precert Matix 210 C10PO1554 Get
2 Enabled Presant Matix 210 C10P01548 Get
3 Enabled Present Matic 210 cioPO1552 Get
‘4 € nabled Prezent Matix 210 C10PO1550 Get
5 Enabled Present Matix 210 C10P01551 Get
6 Enabled Present Matroc 210 C10P01553 Get
7 Enabled Present Matrx 210 C10P01549 Get

Ext

The reader network is ready.
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2.3.2 ID-NET™ Slave Management Through Master

When an ID-NET™ J|ayout has already been configured, it is possible to modify the
configuration of any Slave from VisiSet through the Master.

Connect a PC equipped with VisiSet™ to the Main, or Auxiliary interface of the Master

reader.

Launch VisiSet™ and connect to the Master reader.

From the VisiSet™ Device Menu select "ID-NET™ Status Window" and click on the
"Look For Devices On Network" button to check the status of the expected Slave devices

within the ID-NET™ network.

Click anywhere in the row of the specific slave in the ID-NET Status Window when its
Current Status is "Present”. The Parameter Setup window will be displayed after a time
based on the network speed, with the configuration of the selected slave.

From the specific Slave Parameter Setup Window, change any parameter (not in
interactive mode), save the configuration to a file, or load a configuration from a file.

Send the modified configuration to the slave.

EE Parameter Setup Slave#2
File

| Send |

FIEX
|

20 Codes ] 10 Codes ] Postal Codes ] Image Frocessing ] Mizcelaneous ]
Data Collection ] katch Code ] Symbol Y erification ] Communication ]
Reading System Layout ] Microglyph Codes ] CB¥ Gateway ] Dizplay ] Diagnostics ]

Operating Modes Calbvation |  Digial /D | LEDs And Keypad
OPERATING MODE
Operating kode Phaze Mode

Reading Phaze OM

Acquizition Trigger

MHumber Of Acquizsition

Acquizition Trigger Status

Feading Phaze OFF

Image Acquisition Buffer Size

Ext. Trg. Leading Edge
Contirous

1]
Ahwayz Enabled

Ext. Trig. Trailing Edoe
10

Acquizition Betry Dizahled
ACQUISITION TRIGGER DELAY 1

Stabusz Enabled

Delay Tirme [#100uz] BhO

CAUTION: If a wrong configuration is set or if the Slave Reading System
Layout parameters are changed, the slave could lose the network connection.
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2.4 EXTERNAL MEMORY BACKUP AND RESTORE THROUGH
VISISET™

The "External Memory Backup" or "External Memory Restore" functions allow performing
Complete Configuration and Environmental parameter storage for network and reading
devices. Backup & Restore can be applied to any reader connected through a device having
External Backup Memory, regardless of the reader's network configuration. Backup &
Restore automatically checks whether a previous backup or configuration is already available
for each device, speeding the procedure up and making it more secure.

These functions are supported by VisiSet™ for all reading devices having sw 6.10 and later
when connected to:

e (CBX + BM100 and/or BM2x0 (sw release 2.02.01 and later)
e QL500 (Ethernet TCP/IP) (sw release 2.02.01 and later)

o QLM-Series Gateways (reading device sw release 6.50 and later)

NOTE:
e Before executing a Backup on a BM100 backup module make sure the Write

Protection switch is set to Unlocked.

e |f BM100 and BM2x0 are both installed B&R is automatically performed only on
the BM100 module.

e BM2x0 can execute B&R only with Network up and running (network cable
connected).

QL500 can backup up to 10 nodes (Master + 9 slaves).

Backup

To perform a Backup:

1. Select "External Memory Backup" from the VisiSet™ Device menu

2. You will be warned that the previous backup will be overwritten. Confirm by clicking Yes.

E Confirmation

Start Configuration Backup?

(Old backup will be overwritten)

X No
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The VisiSet™ Main window shows information as the backup procedure is performed and a
message indicating successful completion.

F. Cadibs ation Tool

V. Symbol Verification

A. Run Mode

B. Capture mage

C. Decode Last image

D. View Last image

E. Download Last inage

H. Upload Bitmap mage

Q. Image Buffer

3. Button Function Menu

[Connection: Def_Matric on 172.27.101 .81

Fle Edt Connect Discornect Device Options Tooks Help

: Matrix 210
: Unknown
Communication Port: Ethernet

Standard Application Program for Matrix Family Rel. 6.10
MACNUM: 00:07:BE:01:02:09
DHCP disabled,
IP Address: 172.27.101.81
Subnet Mask: 255.255.0.0
Gateway: 172.27.2.254
DNS1: 172.27.0.32
Backing up local device (Master)...
Local device (Master) successfully backed up
Backing up Slave 1...
Slave 1 successfully backed up
Backup module updated!

External Memory Backup procedure successfully completed.

Reader Status: OFF LINE MODE Log : OFF

Restore

To perform a Restore:

1. Select "External Memory Restore" from the VisiSet™ Device menu

2. You will be warned that the current device configuration(s) will be overwritten. Confirm by

clicking Yes.

Start Configuration Restore?

{Current configuration in device will be ovenwritten)

XNUI

.................................
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The VisiSet™ Main window shows information as the restore procedure is performed and a
message indicating successful completion.

4 visiSet
Fle Edt Connect Discormect Device Options Tools Help

Device: Matrix 210
Model: Unknown
Communication Port: Ethernet
F. Calibe ation Tool
Standard Application Program for Matrix Family Rel. 6.10
V. Symbol Vet ffication MACNWM: 00:07:BE:01:02:09
DHCP disabled.
A. Run Mode IP Address: 172.27.101.81
Subnet Mask: 255.255.0.0
B. Capture image Gateway: 172.27.2.254
DNS1: 172.27.0.32
Restoring local device (Master)...
Local device (Master) successfully restored
Checking configuration...O0K
E. Download Last kmage Configuration saved in Permanent memory!
Local device updated!

C. Decode Last knage

Bitmap mage Checking for ID-NETY Slaves...
Restoring Slave 1...
0. mage Buffer Slave 1 successfully restored

Upload

External Memory Restore procedure successfully completed.
3. Button Function Menu

[Connection: Def _Matrix on 172,27.101.81 Reader Ratus: OFF LINE MOOE Log : OFF

Replacement

The External Memory Restore function also provides easy and secure Single Device
Replacement:

1. Remove the device to be replaced
Connect the new device (make sure the new device has been previously set to default)

Run the Restore procedure by selecting the "External Memory Restore" item (see:
Restore procedure)

26



INTRODUCTION

Erase

To Erase any previous Backup:

1. Select "External Memory Erase" from the VisiSet™ Device menu

2. You will be warned that all device configurations in the current backup will be erased.
Confirm by clicking Yes.

E Confirmation

Any Configuration present in current Backup will be erased

Are you sure you want to proceed?

..................

Yes X No

The VisiSet™ Main window shows a message indicating successful completion.

Fle Edt Connect Discornect Device Options Tools Help

F. Calibe ation Tool

V. Symbol Verification
A. Run Mode

B. Capture knage

C. Decode Last image

D. View Last image

E. Download Last nage

H.

Upload Bitrap knage
Q. kmage Buffer

3. Button Function Menu

[Connection: Def_Matrix on 172,27,101.81

Device: Matrix 210
Model: Unknown
Communication Port: Ethernet

Standard Application Program for Matrix Family Rel. 6.10
MACNUNM: 00:07:BE:01:02:09
DHCP disabled.
IP Address: 172.27.101.81
Subnet Mask: 255.255.0.0
Gateway: 172.27.2.254
DNS1: 172.27.0.32
Backup module erased!

External Memory Erase procedure successfully completed.

Reader Status: OFF LINE MOOE Log : OFF
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List
To see a List of the current Backup:

1. Select "External Memory Read Backup" from the VisiSet™ Device menu.

The VisiSet™ Main window shows a list of devices in the current Backup.

4] visiSet
Fle Edt Connect Discornect Device Options Tools Help

: Matrix 210
: Unknown
Communication Port: Ethernet
F. Calibe ation Tool
Standard Application Program for Matrix Family Rel. 6.10
V. Symbol Vet fication MACNUM: 00:07:BE:01:02:09
DHCP disabled.
A. Run Mode IP Address: 172.27.101.81
Subnet Mask: 255.255.0.0
B. Capture image Gateway: 172.27.2.254
DNS1: 172.27.0.32
List of backup present on External Memory :
MASTER:Matrix 210
SLAVE 1:Matrix 410

C. Decode Last image
D. View Last image

E. Download Last mage
H. Upload Bitmap knage

0. mage Buffer

3. Button Function Menu

[Connection: Def _Matrix on 172,27.101.81 Reader Status: OFF LINE MOOE Log : OFF

The following is a list of possible error messages displayed on the VisiSet™ main window in
case of an External Memory function failure:

e Module not present: backup module not mounted (BM100) or not ready (QL500,
BM2x0)

e Unable to Read Backup State: VisiSet™ is unable to connect to the backup memory

e Backup function not allowed: when device is in X-PRESS™ Menu mode (BM100,
QLM) or is out of memory (QL500)

e Failed! (Device not found): Master is unable to reach the addressed device
e Failed! (Module is write protected): BM100 Write Protection switch is set to Locked
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2.5 X-PRESS™ HUMAN MACHINE INTERFACE

X-PRESS™ is the intuitive Human Machine Interface designed to improve ease of
installation and maintenance.

Status information is clearly presented by means of the five colored LEDs, whereas the
single push button gives immediate access to the following relevant functions:
e Learn to self-detect and auto-configure for reading unknown codes.

e Setup to perform Exposure Time and Gain calibration.

e Aim/Locate to turn on the blue ring to aid positioning.

e Test with bar graph visualization to check static reading performance.

2.5.1 X-PRESS™ Functions

Quick access to the following functions is provided by READY
an easy procedure using the push button: )
GO0

1 — Press the button (the Status LED will give a
visual feedback). TRIGGER

2 — Hold the button until the specific function LED is con

on (Test, Focus, Setup or Learn).
STATUS

3 — Release the button to enter the specific function.

Once button is pressed, the cycle of LEDs activation is as follows:

READY

READY

GOOD GOOD
0e TRIGGER [ TRIGEER %
] Wi Y ) ]
LE et @D C:
as gc ' =15
= — oM =
= o = oD -
A STATUS A STATUS A
> > >
Release button Release button Release button
to Exit to enter Test Mode to enter Aim/Locate Mode
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READY READY

D 9 GED R LEARN

600D 690D

TRIGGER (1 TRIGGER (1 fs

OED O s

< ac < ac ac
= ¢ = ¢ X
STATUS A STATUS A A
> > = (cycle)

Release button Release button Release button
to enter Setup Mode to enter Learn Mode to Exit

Test Mode (Function 1)

Once entered, the Bar Graph on the five LEDs is activated and if the imager starts reading
codes the Bar-Graph shows the Good Read Rate. In case of a NO READ condition, only the
Status LED is on and blinks.

The Bar Graph has the following meaning:

READY

S 6 e
GOOD

S © =D
TRIGGER e

S ea» -
com L

> 40% oD -
STATUS

220% -0 &

To exit the Test Mode, press the X-PRESS™ push button once.

NOTE: By default, the Test exits automatically after three minutes.

Aim/Locate (Function 2)

This function causes the blue ring to turn on. Since the blue ring is centered on the FOV it
can be used to position the imager on the code. The Aim LED blinks to indicate this state.

To exit the Aim/Locate Mode, press the X-PRESS™ push button once. The blue ring turns
off.
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Setup (Function 3)

Once entered, the imager automatically performs Image Acquisition parameter calibration for
the specific code presented to it.

The Setup LED will blink until the procedure is completed.

The Setup procedure ends when the Image Acquisition parameters are successfully saved in
the reader memory, the Setup LED will remain on continuously and Matrix 210™ emits 3 high
pitched beeps.

If the calibration cannot be reached after a timeout of about 5 (five) seconds Matrix 210™ will
exit without saving the parameters to memory, the Setup LED will not remain on continuously
but it will just stop blinking. In this case Matrix 210™ emits a long low pitched beep.

Learn (Function 4)

Once entered, the imager starts a procedure to automatically detect and recognize codes
which are presented to it.

The Learn LED will blink until the procedure is completed.

The Learn procedure ends when the Image Processing and Decoding parameters are
successfully saved in the reader memory, the Learn LED will remain on continuously and
Matrix 210™ emits 3 high pitched beeps.

If the calibration cannot be reached after a timeout of about 3 (three) minutes, Matrix 210™ will
exit without saving the parameters to memory, the Learn LED will not remain on continuously
but it will just stop blinking. In this case Matrix 210™ emits a long low pitched beep.

2.5.2 Diagnostic Indication

The "STATUS" and "READY" LEDs blink simultaneously while the "GOOD" LED is on to
signal the presence of an error. Diagnostic message transmission on interfaces can be
enabled to provide details about specific error conditions. See the Diagnostic Error
Conditions chart in the Help On Line.

LED STATUS
READY BLINK
Wc GOOD ON to indicate an error
@E TRIGGER
?:f COM
5"”2 A STATUS BLINK
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2.6 MODEL DESCRIPTION

Matrix 210™ readers are described by their model number which indicates the
characteristics listed in the diagram below. Not all combinations are available. For a
complete list of combinations see the Models tab on the Product page of the website.

MATRIX 210 XXX-XXX

Sensor Size
2 = WVGA (752x480)

llluminators

1 = STD Internal llluminator

Focus Distance

1 = Near

2 = Medium
3 =Far

4 = UHD

> Options

0 = Standard
1 = ESD Safe
2 = ESD Safe + YAG Cut Filters

— Interface

0 = Serial
1 = Ethernet
2=USB

> Reading Window

0=90°
1 = Straight
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2.7 ACCESSORIES

The following accessories can be used with the Matrix 210 2xx-x0x and Matrix 210 2xx-x1x

model readers.

Accessory Description Order No.
External llluminator
LT-700 Linear Array Lighting System 93A401028
BK-21-000 LT-700 Fixing Bracket 93ACC0052
Cables
CAB-ETH-M01 M12-IP67 Ethernet Cable (1M) 93A051346
CAB-ETH-M03 M12-IP67 Ethernet Cable (3M) 93A051347
CAB-ETH-M05 M12-IP67 Ethernet Cable (5M) 93A051348
Connectivity
CBX100 Compact Connection Box 93A301067
CBX500 Modular Connection Box 93A301068
BM100 Backup Module for CBX100/500 93ACC1808
BM150 Display Module for CBX500 93ACC1809
BM200/BM210 Ethernet TCP/IP Module STD/IP65 for CBX500 93ACC1851, 93ACC1852
BM300/BM310 Profibus Module STD/IP65 for CBX500 93ACC1810, 93ACC1811
BM400 DeviceNet Module IP65 for CBX500 93ACC1814
93ACC1812, 93ACC1813,
BM500/BM510/BM520 EtherNet/IP Module STD/IP65/IP54 for CBX500 03ACC1840
BM600 CAN Open Module for CBX500 93ACC1815
BM700 Profinet 10 Module for CBX500 93ACC1816
BM1100 CC-Link Module for CBX500 93ACC1845
BM1200/BM1210 Modbus TCP Module STD/IP65 for CBX500 93ACC1848, 93ACC1849
BA100 DIN Rail Adapters 93ACC1821
BA200 Bosch Adapters 93ACC1822
QL150 Quick Link Slave ID-NET + Service T-Connector 93ACC1868
QL300 Quick Link Master ID-NET - Serial Host Connector 93ACC1862
QL500 Quick Link Master ID-NET - Ethernet Host Connector 93ACC1864
QLM500 Quick Link Metal Master ID-NET - EtherNet/IP Gateway 93ACC0037
QLM600 Quick Link Metal Master ID-NET - Profibus Gateway 93ACCO0033
QLM700 Quick Link Metal Master ID-NET - Profinet IO Gateway 93ACCO0038
Power Supplies
PG6002 AC/DC Power Supply Unit (US) 93ACC1718
PG6001 AC/DC Power Supply Unit (UK) 93ACC1719
PG6000 AC/DC Power Supply Unit (EU) 93ACC1720
Sensors
MEP-593 Photocell Kit PNP (PH-1) 93ACC1791
MEP-543 Photocell Kit-NPN 93ACC1728

NOTE: Matrix 210™ 2xx-x2x models, (USB), are used for point-to-point
connections to PCs or USB Hubs and have no accessories.
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2.8 APPLICATION EXAMPLES
2.8.1 Document Handling

Matrix 210™ is profitably used in the omnidirectional reading of 2D, stacked, linear and postal
codes for example in automated document handling and mail processing systems (see Figure 15).

Figure 15 - Address Coded in Data Matrix Symbology for Automated Mail Processing

2.8.2 Deformed or Overprinted Code Reading

Matrix 210™ assures the reading of deformed and / or overprinted codes, even though
damaged or printed on high reflective surfaces (see Figures 18, 19, 20).

Figure 18 - Barcode Printed on Curved Surface Readable by Matrix 210™ in spite of Image Optical
Distortion
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2.8.3 Direct Part Marking

Matrix 210™ is also very powerful in reading low-contrast direct part marked codes (see
Figures 21, 22, 23, 24 and 25).

Figure 19 - Dot Matrix Code Directly Marked on Metal Surface by Using Dot Peening Technology

Figure 20 - Dot Peening Marking on Metal Surface with Multi-dot per Code Element

Figure 21 - Directly Marked Dot Matrix Code Characterized by Outstanding Separation Distance between
Adjacent Code Elements

2.8.4 Ink-Jet Printing Technology

Gy
i

Figure 22 - Dot Matrix Code Directly Marked on PCB Copper Pad by Using Ink-Jet Technology
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2.8.5 Laser Marking/Etching Technology

:‘,"" @™ T .
:‘S\\\©/ .’J

Figure 23 - Data Matrix Code Directly Marked on PCB Surface by Using Laser Etching Technology

CAUTION: If application codes must be read which are produced by Laser
Marking in real time, use Matrix 210™ models incorporating YAG Filters in
order to avoid burning the CMOS sensor.

2.9 EXTERNAL LIGHTING SYSTEMS

In some direct part marking applications best reading results are obtained by using an
external lighting system.

The LT-700 Linear Array Lighting System provides a high intensity light source designed for
the following applications:

e with uneven, noisy and scratched surfaces

e where dot peening or laser etching codes are directly marked onto metal surfaces or
PCBs and need to be highlighted. Here the use of more than one LT-700 at different
positions can remove any shadowing effect.

¢ in the presence of highly reflective surfaces (metal, glass, etc.) causing direct reflections.
Low light path to surface angles strongly reduce direct reflections.

Figure 24 - LT-700 Linear Array Lighting System
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3 INSTALLATION

3.1 PACKAGE CONTENTS

Verify that the Matrix 210™ reader and all the parts supplied with the equipment are present
and intact when opening the packaging; the list of parts includes:

a Matrix 210™ reader
d Quick Reference Guide
a Test Chart
a

Mounting Kit

e Mounting Screws (2)
¢ Washers (2)

¢ Mounting Bracket

Figure 25 - Package Contents
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3.2 MECHANICAL DIMENSIONS

Matrix 210™ can be installed to operate in different positions. The four screw holes (M3 x 4)
on the body of the reader are for mechanical fixture (Figure 26).

The diagram below gives the overall dimensions of the reader and may be used for its
installation.

Refer to par. 3.3 for various mounting solutions and correct positioning and chp. 6 for
Reading Distance considerations.

7 25.0
[0.29] [~ [T [0.98] | |
i i = o
- g3
9] =2
<8 1] L e
N 2‘ | =
J J U \Optical axis
‘ ‘
o 45
mm
[in]
[[]
il T
6 | 50
[0.25] [1.97]

Figure 26 — Straight Model Overall Dimensions

7 250 9.0

[0.29] [0.98] T [0.36]

i M3X4 |
5 il ™ / -

o
oz . .
o, Optical axis ~

| | 1 mm
r [in]
L

45
[1.76]

L 54
[2.13]

Figure 27 — 90° Model Overall Dimensions
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60°
30°
— An 90°
% )
éﬁ )
2,
I I N 1
12.5
[0.49] 64
[0?38] [2.52]
[ [
/)\
o 60°
\
\< \\ 30°
)
Q S g? 6.2 n°3
A
\Y

mm
[in]
g /7\ g0
=} \ =
60° N
b RY a
= 3
=
\ |
18.5 38
[0.73] 6.2 n°2 [1.50] ‘

=)

ylla
60° r
NEIE-
J e
18.5
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Figure 29 - ST-337 Mounting Bracket Overall Dimensions
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3.3 MOUNTING AND POSITIONING MATRIX 210™

Using the Matrix 210™ mounting brackets you can obtain rotation on the various axes of the
reader as shown in the diagrams below:

ci; Tilt

Figure 30 —90° Model with ST-337 Mounting Bracket - Internal Positioning

<E> Tilt

Figure 32 —Mounting Bracket External Positioning
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Matrix 210™ is able to decode code labels at a variety of angles, however significant angular
distortion may degrade reading performance.

When mounting Matrix 210™, take into consideration these ideal label position angles: Pitch
or Skew 10° to 20° and Tilt 0°.

Note: Since Matrix 210™ is omni-directional on the code plane, the Pitch and Skew angles
have the same significance with respect to the code plane. However in some advanced code
reading applications performance can be improved by modifying the Pitch angle.

Follow the suggestions below for the best orientation:

The Pitch and Skew angles are represented by the values P and S in Figure 33 and in Figure
34. Position the reader in order to avoid the direct reflection of the light emitted by the Matrix
210™ reader; it is advised to assure at least 10° for one of these angles. In some cases, such
as low contrast or low illumination, it can be useful to use a Pitch or Skew angle = 0°.

P

(AT

5

Minimize

iy

‘o“ E
b

Assure at least 10°

Figure 33 - Pitch angle Figure 34 - Skew angle

The Tilt angle is represented by the value T in Figure 35. Matrix 210™ can read labels with

any tilt angle.

T
Minimize
Figure 35 - Tilt angle

See chp. 6 for FOV and Reading Distance considerations.
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4 CBXELECTRICAL CONNECTIONS

All Matrix 210™ 25-pin models can be directly connected to a CBX connection box.

We recommend making system connections through one of the CBX connection boxes since
they offer the advantages of easy connection, easy device replacement and filtered
reference signals.

NOTE: If you require direct wiring to the reader the details of the connector
pins and relative connections are indicated in Appendix A.

The table below gives the pinout of the CBX100/500 terminal block connectors. Use this
pinout when the Matrix 210™ reader is connected by means of the CBX100/500:

CBX100/500 Terminal Block Connectors

Input Power
Vdc Power Supply Input Voltage +
GND Power Supply Input Voltage -
Earth Protection Earth Ground
Inputs
+V Power Source — External Trigger
I11A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference — External Trigger
+V Power Source — Inputs
I12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference — Inputs
Outputs
+V Power Source - Outputs
-V Power Reference - Outputs
01+ Output 1 +
O1- Output 1 -
02+ Output 2 +
O2- Output 2 -
Aucxiliary Interface
TX Auxiliary Interface TX
RX Auxiliary Interface RX
SGND Auxiliary Interface Reference
ID-NET™
REF Network Reference
ID+ ID-NET™ network +
ID- ID-NET™ network -
Shield Network Cable Shield
Main Interface
RS485 RS485
RS232 Full-Duplex Half-Duplex
X TX+ RTX+
RX *RX+
RTS TX- RTX-
CTS *RX-
SGND SGND SGND

* Do not leave floating, see par. 4.2.2 for connection details.
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NOTE: To avoid electromagnetic interference when the reader is connected
to a CBX connection box, verify the jumper positions in the CBX as indicated
in its Installation Manual.

4.1 POWER SUPPLY

Power can be supplied to the reader through the CBX100/500 spring clamp terminal pins as
shown in Figure 36:

Power Supply
VGND
V+ Earth
in Ground
e s [ [ e [ | [ [ [ ]
Vdec GND | & REF D+ ID- | & |[SGND TX RIS RX CTS
pPOWER | 7% ID-NET 9% | man RITX+ RTX- Rx+ Rx- |1

Figure 36 - Power Supply Connections

The power must be between 10 and 30 Vdc only.
It is recommended to connect the device CHASSIS to earth ground (Earth) by setting the

appropriate jumper in the CBX connection box. See the CBX Installation Manual for details.

4.2 MAIN SERIAL INTERFACE

CAUTIONE: Do not connect to the Main Interface spring clamp terminals if
using Host Interface Modules (Fieldbus) with the CBX500.

The signals relative to the following serial interface types are available on the CBX spring
clamp terminal blocks.

The main serial interface type and its parameters (baud rate, data bits, etc.) can be
defined by the user via VisiSet™ software. The RS485 half duplex is automatically set
whenever MUX32 communication protocol is enabled. For more details refer to the
"Communication” folder in the VisiSet™ Help On Line.

Details regarding the connections and use of the interfaces are given in the next paragraphs.
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4.2.1 RS232 Interface

The RS232 interface can be used for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code
data and reader configuration by VisiSet™.

The following pins are used for RS232 interface connection:

CBX100/500 Function
TX Transmit Data
RX Receive Data
RTS Request To Send
CTS Clear To Send
SGND Signal Ground

It is always advisable to use shielded cables. The overall maximum cable length must be
less than 15 m (49.2 ft).

USER INTERFACE
SGND RXD TXD

| s e | s | o
REF 1D+ ID- | & |SGND TX RTS RXx CTS
ID-NET % | MAIN (R)TX+ (R)TX- RX+ RX-

Qll
Qll
& Olll

Vdc GND
POWER

/]

READER SGND TX RX
RTS CTs

Figure 37 — RS232 Main Interface Connections Using Hardware Handshaking

The RTS and CTS signals control data transmission and synchronize the connected devices.

START END
OF OF
TRANSMISSION TRANSMISSION
+V
RTS
-V —fp— f—
' DATA DATA Il
Y | TRANSMISSION TRANSMISSION |
TX DATA I [ci)c2 ) (csfcafcs) |
-V
' n
| TRANSMISSION n
: | STOPPED | ﬂ
s || |
oy , ENABLED ENABLED |
-V
IDLE DISABLED DLE

Figure 38 - RS232 Control Signals

If the RTS/CTS handshaking protocol is enabled, the Matrix 210™ activates the RTS output
to indicate a message is to be transmitted. The receiving unit activates the CTS input to
enable the transmission.
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4.2.2 RSA485 Full-Duplex Interface

The RS485 full-duplex (5 wires + shield) interface is used for non-polled communication
protocols in point-to-point connections over longer distances (max 1200 m / 3940 ft) than
those acceptable for RS232 communications or in electrically noisy environments.

The CBX pinout follows:

CBX100/500 Function
TX+ RS485 Transmit Data +
RX+ RS485 Receive Data +
TX- RS485 Transmit Data -
RX- RS485 Receive Data -
SGND Signal Ground

USER INTERFACE

RX485+ TX485+

SGND

{ | s s | s s Y o s

vdc GND|<«, [REF 1+ ID- |8 [seno TX  RTS  Rx cTs

POWER 7% ID-NET % | maN RITX+ RITX- Rx+  Rx- |1
READER SGND TX+ RX+

TX- RX-

Figure 39 - RS485 Full-duplex Connections

NOTE: For applications that do not use RX485 signals, do not leave these
lines floating but connect them to SGND as shown below.

USER INTERFACE
RX485+

SGND M RX485-

e Y s | s |
REF D+ ID-
ID-NET

—
Ly
S
%

@il
@il

| s |
SGND  TX RTS RX CTs
MAIN (R)TX+ (R)TX- RX+ RX-

—
&
5

Vdc GND
POWER

d

READER SGND TX+

TX-

Figure 40 - RS485 Full-duplex Connections using Only TX Signals
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4.2.3 RSA485 Half-Duplex Interface

NOTE: This interface is provided for backward compatibility. We recommend
using the more efficient ID-NET™ network for Master/Slave or Multiplexer

layouts.

The RS485 half-duplex (3 wires + shield) interface is used for polled communication
protocols.

It can be used for Multidrop connections with a Datalogic Multiplexer, (see par. Error!

Reference source not found.) exploiting a proprietary protocol based on polled mode called
MUX32 protocol, where a master device polls slave devices to collect data.

CBX100/500 Function
RTX+ RS485 Receive/Transmit Data +
RTX- RS485 Receive/Transmit Data -
SGND Signal Ground
USER INTERFACE
RTX485+
SGND RTX485-
| s 1 | s [ s | s [ | s s ) { s o | o |
O|0|00|I010O O OJ
Vdc GND | & REF ID+ ID- | &, |[SGND TX RTS RX CTs
POWER | ID-NET % | MAIN R)TX+ (RITX- RX+  RX- 1‘

READER SGND RTX+
RTX-

Figure 41 - RS485 Half-duplex Connections
This interface is forced by software when the protocol selected is MUX32 protocol.

In a Multiplexer layout, the Multidrop address must also be set via serial channel by the
VisiSet™ utility or by the Host Programming Mode.

Figure 42 shows a multidrop configuration with Matrix 210™ readers connected to a
Multiplexer.

CAUTION: This is an example of multidrop wiring. Consult the multiplexer
manual for complete wiring instructions.
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PG-6000

Main Interf
MULTIPLEXER ain Interface HOST
RS232/RS485
120 Ohm $ Multidrop - -
Multidrop +
Multidrop GND
Shield to Earth Shield

V-
V+

Reader
Slave
#0

CBX100/500

Reader
Slave
#1

* ]

1 Shield
Tfloating

L] L ]
° o
L] [
L] L ]
[ ] *
. )
L] L]
L] ®
o
L] .l
[ ] (]
RS485 HD
Termination Resistor.
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[~ RTX+

SGND
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Earth
GND _-l_—
Vdc
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Slave
(up to 31)

*
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Tfloating
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yjbua xe w 00ZL
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Ok

PG-6000

Earth
o] 1
Vdc

CBX100/500

RTX- —A)

X0

l Shield
Tfloating

RS485 HD
Termination Resistor.

RTX+

SGND

Shield

N

PG-6000

Earth
GND _-l—

Vdc

Figure 42 - Matrix 210™ Multidrop Connection to a Multiplexer

* When using CBX500, the Main interface multidrop network signals: Shield, SGND, RTX+and RTX- are

repeated on terminal connector row 4 to facilitate system cabling.
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4.3 ID-NET™ INTERFACE

CBX100/500 Function
Shield Network Cable Shield
ID+ ID-NET™ network +
ID- ID-NET™ network -
REF Network Reference

4.3.1 ID-NET™ Cables

The following instructions are referred to Figure 44, Figure 45 and Figure 46.

« The general cable type specifications are: CAT5 twisted pair + additional CAT5 twisted
pair, shielded cable AWG 24 (or AWG 22) stranded flexible.

We recommend using DeviceNet cables (drop or trunk type) to the following reference
standards:

AN50325 — |[EC 62026
UL STYLE 2502 80°C 30V

. Cable Shield MUST be connected to earth ground ONLY at the Master.
« NEVER use ID-NET™ cable shield as common reference.

.« The ID-NET™ max cable length depends on the baudrate used, (see the Baudrate Table
below).
« For Common Power Connections use only 2 wires (ID+ and ID-).

DC Voltage Power cable (Vdc — GND) should be handled as a signal cable (i.e. do
not put it together with AC cable):

Wire dimensioning must be checked in order to avoid voltage drops greater than 0.8
Volts.

Cable should lie down as near as possible to the ID-NET™ cable (avoiding wide
loops between them).

. Reader's chassis may be connected to earth.

« Network inside the same building.

Baudrate Table
Baud Rate 125 kbps 250 kbps 500 kbps 1Mbps
Cable Length 1200 m 900 m 700 m *

* Application dependent, contact your Datalogic Automation representative for details.

NOTE: The default ID-NET™ baudrate is 500 kbps. Lower ID-NET™
baudrates allow longer cable lengths. The baudrate is software configurable

by authorized Datalogic Automation personnel only.

48



CBX ELECTRICAL CONNECTIONS o

4.3.2 ID-NET™ Response Time

The following figure shows the response time of the ID-NET™ network. This time is defined
as the period between the Trigger activation and the beginning of data transmission to the
Host.

Max ID-NET™ Response Time

240

220 e

200 e

180 -

160 Lo

140 -

120 -

100 O — =

Response Time (ms)
1
\

80 - o ]

60 o ——

40

20

o 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16

Number of Nodes
— 500 kbps = = - 250 kbps seresees 125 kbps

Figure 43 — ID-NET™ Response Time

CONDITIONS:

e |ID-NET™ M/S Synchronized layout
e message length = 50 bytes per node
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CBX1 OOI5(£ Main Interface HOST
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Figure 44 — ID-NET™ Network Connections with isolated power blocks
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CBX100/500 Main Interface HOST
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Figure 45 - ID-NET™ Network Connections with Common Power Branch Network
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Figure 46 — ID-NET™ Network Connections with Common Power Star Network
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4.3.3 ID-NET™ Network Termination

The network must be properly terminated in the first and last reader of the network. This is

done by setting the ID-NET™ Termination Resistance Switch in the CBX100/500 to ON.

4.4 AUXILIARY RS232 INTERFACE

The RS232 auxiliary interface is available for Point-to-Point, Pass Through or Master/Slave
connections. When it is connected to the host computer it allows both transmission of code

data and reader configuration by VisiSet™.

The parameters relative to the aux interface (baud rate, data bits, etc.) as well as particular
communication modes such as LOCAL ECHO can be defined through the Communication

folder of the VisiSet™ utility program.

The 9-pin female Auxiliary Interface connector inside the CBX is the preferred connector for
device configuration or communication monitoring.

5 1

00000
(ONONONO)
U

9 6

Figure 47 - 9-pin female connector

If permanent system wiring is required, the following pins are used to connect the RS232

auxiliary interface:

CBX100/500 Function
RX Auxiliary Interface Receive Data
TX Auxiliary Interface Transmit Data
SGND Auxiliary Interface Reference

USER INTERFACE
RX TX

o 1 s | o s 1 s | s |
1+ 01- 02+ O02-| +Vv  I12A  12B -V
UTPUTS INPUT2

@il

@il
< O[f
o[l

+V (0]
[o]

e | s | s

OO0

REF ID+ ID-
ID-NET

Oll
Ol
& Ol
& Ol
Ol
Ol
ol

+V 1A  11B
TRIGGER

Vdc GND
POWER

Reference

Figure 48 - RS232 Auxiliary Interface Connections

NOTE: Do not connect the Aux Interface to the CBX spring clamp
connectors and the 9-pin connector simultaneously.
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4.5 INPUTS

There are two optocoupled polarity insensitive inputs available on the reader: Input 1
(External Trigger) and Input 2, a generic input:

The External Trigger can be used in One Shot Mode or in Phase Mode. Its main functions
are:

e acquisition trigger in One Shot Mode
¢ reading phase-ON/reading phase-OFF command in Phase Mode

The main functions of the general purpose Input 2 are:
e second external trigger in Phase Mode
e match code storage command when the Match Code option is enabled

The electrical features of both inputs are:
Vag = 30 Vdc max.
Iin = 12 mA (reader) + 12 mA (CBX) max.

The active state of these inputs are selected in software. Refer to the VisiSet™ Help On
Line.

An anti-disturbance filter is implemented in software on both inputs so that the minimum
pulse duration is = 0.5 milliseconds. This value can be increased through the software
parameter Debounce Filter, see the Digital I/O folder in the VisiSet™ Help On Line for further
details.

These inputs are optocoupled and can be driven by both NPN and PNP type commands.

NOTE: Polarity insensitive inputs assure full functionality even if pins A and
B are exchanged.

The connections are indicated in the following diagrams:

CBX100/500 Function
+V Power Source - External Trigger
I1A External Trigger A (polarity insensitive)
11B External Trigger B (polarity insensitive)
-V Power Reference - External Trigger

The yellow Trigger LED (Figure 14, 5) is on when the active state of the External Trigger
corresponds to ON.
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EXTERNAL TRIGGER INPUT CONNECTIONS USING MATRIX 210™ POWER

CAUTION: Power is available directly to the Input Device, independently
from the Power Supply Switch inside the CBX.

PH-1 Photocell (PNP)

(brown)

(black) (blue)

= — —
REF D+ ID- +  MA 1B -V |scnD
ID-NET % TRIGGER Aux |2

e J e
Vdc GND
POWER

& Olll
* Ol

Figure 49 — PH-1 External Trigger Using Matrix 210™ Power

NPN Photocell

Power to Input

Photocell Signal
Photocell
Reference

—

—
+V 1A 1B -V |SGND
TRIGGER AUX

o ) o | s s Y | s | s |
Vvdc GND|<& |REF 1D+ ID-
POWER % ID-NET

&
< Oll

Figure 50 - NPN External Trigger Using Matrix 210™ Power

EXTERNAL TRIGGER INPUT CONNECTIONS USING EXTERNAL POWER

PNP Photocell

Input
Signal

Pulled down to External
Input Device Reference

g -y

[} ) s | s | | s | s | s | — i
vdc GND | <&, |REF D+ ID- +V  MA 1B -V |seno
POWER 7% ID-NET % TRIGGER aux |2

SEell

Figure 51 - PNP External Trigger Using External Power

NPN Photocell

Pulled up to External
Input Device Power

Input
Signal

e Y | o |
Vdc GND
POWER

——

{ e s | e | | s |
REF 1D+ 1D- |9 | +v 1A 1B v |seno
ID-NET % TRIGGER Aux |2

& Q|

Figure 52 - NPN External Trigger Using External Power
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CBX100/500 Function
+V Power Source - Inputs
12A Input 2 A (polarity insensitive)
12B Input 2 B (polarity insensitive)
-V Power Reference - Inputs

INPUT 2 CONNECTIONS USING MATRIX 210™ POWER

CAUTION: Power is available directly to the Input Device, independently
from the Power Supply Switch inside the CBX.

Input Device
Power to
Input Device
Input Input Device
Signal Reference

—

—

—

—

—

@il

— | s |
-V O1+ 0O1- 02+ 02-| +v 12A 12B -V
OUTPUTS

+V

INPUT2 aux |3 ‘

PNP Input 2 Using Matrix 210™ Power

Input Device

Power to Input
Input Device Signal

Input Device
Reference
[ s s | s Y o | s | — i
+V -V O1+ O1- 02+ O02- +V I2A 12B -V TX RX
OUTPUTS INPUT2 AUX 3

NPN Input 2 Using Matrix 210™ Power

INPUT 2 CONNECTIONS USING EXTERNAL POWER

Input Device
Input
Signal

Pulled down to External
Input Device Reference

Gl0[0[0/0[0[0|8|8[0[00

+V

O1+ O1- 02+ 02-] +v 12A 2B -V

X RX
OUTPUTS

INPUT2 ax |3 ‘

Figure 53 - PNP Input 2 Using External Power
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Input Device

Pulled up to External
Input Device Power

Input
Signal

s e s | e s Y | s s | —
+V -V 01+ 0O1- 02+ 02-| +v 12A 2B -V X RX
OUTPUTS INPUT2 AUX 3

o[l
Ol

Figure 54 - NPN Input 2 Using External Power

4.6 OUTPUTS

Two optocoupled general purpose outputs are available. The meaning of the two outputs
Output 1 and Output 2 can be defined by the user. They are typically used either to signal the
data collection result or to control an external lighting system.

CBX100/500 Function
+V Power Source - Outputs
o1+ Output 1 +
O1- Output 1 -
02+ Output 2 +
02- Output 2 -
-V Power Reference Outputs

The electrical features of the two outputs are the following:

Vce = 30 Vdc max.
Ice = 40 mA continuous max.; 130 mA pulsed max.

By default, Output 1 is associated with the Partial Read and No Read events, which activates
when the code(s) signaled by the external trigger are not decoded, and Output 2 is
associated with the Complete Read event, which activates when all the selected codes are
correctly decoded.

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/0 folder in the VisiSet™ Help On Line for further details.

57



58

MATRIX 210™ REFERENCE MANUAL

OUTPUT CONNECTIONS USING MATRIX 210™ POWER

CAUTION: Power is available directly to the Output Device, independently
from the Power Supply Switch inside the CBX.

Output Device

Power to Output
Output device Signal

s Y s |

Output device
Reference
—

S[0[00

OO

+V -V 01+ O1-
OUTPUTS

02+ 02- ] +V I2A  12B

INPUT2

00

1R

AUX

RX|3‘

Figure 55 - Open Emitter Output Using Matrix 210™ Power

Output Device

Power to
Output device

Output device
Reference
Output
Signal
* [ ) s Y | s s | s s |
®/®/0[0[0[0]0

e

0

e

+V V. 01+ O1-

OUTPUTS

02+ 02-| +v 12A 12B

INPUT2

-V

>
A

RX
ux |3‘

Figure 56 - Open Collector Output Using Matrix 210™ Power

OUTPUT CONNECTIONS USING EXTERNAL POWER

Qutput Device

Pulled up to External
Output Device Power

Qutput
Signal
] =] =1 =] =l =l = =l =1 =)
W vV Ol+ 01 02+ 02| +v 1A 2B v | X RX
OUTPUTS INPUT2 aux |3

Figure 57 - Output Open Emitter Using External Power

Output Device

Output
Signal

Pulled down to External
Output Device Reference

—

—

O

O

e

0

0

0

e

0

O[0

+V

o1+ O1- 02+
OUTPUTS

02-

+V

I12A

12B

INPUT2

-V

™

AUX

RX|3‘

Figure 58 - Output Open Collector Using External Power
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4.7 EXTERNAL LIGHTING SYSTEMS

If an External llluminator is used, it can be powered from the CBX connection box. It must be
connected to the Vdc and GND terminal clamps.

A\

CAUTION: Power is available directly to the llluminator, independently from
the Power Supply Switch inside the CBX.

In the case of the LT-700 illuminator, one of the available digital outputs must be connected
as the control signal. In VisiSet™, configure the Output Line Function parameter to "External
Lighting System” and the Matrix Output x External Lighting System Mode parameter to

"Triggered".

Below is a table summarizing the External Illuminator wiring and power requirements:

Control Signal for LT-700
illuminators

O

@)l

®60 0000

O[l

O[l

o[

+V -V

O1+ O1- 02+ 02-| +v 12A 12B -V
OUTPUTS INPUT2

>

AUX

RX3

—l

0l0[0I0/01010

O

O

Vdc  GND
POWER

. |rRer o+ - ]S |+ 1A 1B
% ID-NET % TRIGGER

-V

SGND
AUX

Power to External

llluminator

Figure 59 — External Lighting System Connections

llluminator Wire Color CBX/Matrix Signal Meaning

LT-700 Red Vdc 10 to 30 Vdc
Black GND Ground
White Earth Shield/Earth Ground
Green O1- or O2- Control Signal -
Yellow 01+ or 02+ Control Signal +
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4.8 ON-BOARD ETHERNET INTERFACE
(Matrix 210 2xx-x1x models only)

The on-board Ethernet Interface can be used for TCP/IP communication with a remote or
local host computer by connecting the reader to either a LAN or directly to a host PC. There
is no need to use a crossover adapter since Matrix 210™ incorporates an auto-cross
function.

A CAB-ETH-MOx cable can be used to connect to a LAN.

On the Matrix 210™ Ethernet interface the following communication channels are available:
e Data Socket
e Image Socket
e WebSentinel Socket
e Image FTP Client
e HTTP Server
e EtherNet/IP
e Profinet IO
e Modbus TCP

For further details refer to the Ethernet Folder in the VisiSet™ Help On Line and to the
"Matrix Ethernet Service Guide.pdf* document provided as supplementary documentation.

4.9 USER INTERFACE - HOST

The following table contains the pinout for standard RS232 PC Host interface. For other user
interface types please refer to their own manual.

RS232 PC-side connections

1 5 1 13
060000606 OCGOOOGOONOS

000600 OGOSOIOSIOSIODS

6 9 14 25

9-pin male connector 25-pin male connector

Pin Name Pin Name
2 RX 3 RX
3 TX 2 TX
5 GND 7 GND
7 RTS 4 RTS
8 CTS 5 CTS
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5 TYPICAL LAYOUTS

The following typical layouts refer to system hardware configurations. However, they also
require the correct setup of the software configuration parameters. Dotted lines in the figures
refer to optional hardware configurations within the particular layout.

5.1 POINT-TO-POINT

5.1.1 Serial Host
(2xx-x0x and 2xx-x1x models)

In this layout the data is transmitted to the Host on the main serial interface. The RS232
auxiliary interface can be used for reader configuration by connecting a laptop computer
running VisiSet™. Host Mode programming can be accomplished either through the main
interface or the Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the main interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

PG6000 -_ cEx

Matrix 210™ |5 ‘Iﬁn
- W o
I ® Main Serial Interface (RS232 or RS485 Full-Duplex)

| Terminal
[ ] @ @ Auxiliary Serial Interface (Local Echo) (RS$232)
(3 External Trigger (for One Shot or Phase Mode)

Figure 60 — Serial Interface Point-to-Point Layout
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5.1.2 Embedded (On-Boad) Ethernet
(2xx-x1x models only)

“In a Point-to-Point layout the reader is connected to a local host by using a CAB-ETH-MOx
cable There is no need to use a crossover adapter since Matrix 210™ incorporates an auto-
cross function.

@] @

CAB-ETH-MOx

Ll Matrix 210™

® Ethernet Interface
@ Auxiliary Serial Interface (Local Echo) (RS232)
® External Trigger (for One Shot or Phase Mode)

PG 6000 —@— D"""‘I

Figure 61 - Ethernet Point-to-Point Layout

In this layout, before proceeding with the connection, it is necessary to configure the reader
Ethernet parameters via VisiSet™. For further details, see “Configuration Through Ethernet’
and the Ethernet Folder in the VisiSet™ Help On Line.
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5.1.3 TCP/IP Ethernet (BM2x0)

In this layout the data is transmitted to the Host on the TCP/IP Ethernet interface (CBX500
with BM200/210 Host Interface Module installed). The RS232 auxiliary interface can be used
for reader configuration by connecting a laptop computer running VisiSet™. Host Mode
programming can be accomplished either through the TCP/IP Ethernet interface or the
Auxiliary interface.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the TCP/IP Ethernet selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (for example a pulse from a photoelectric sensor) when the object enters its
reading zone.

Power
1O |0Q g 9
— P @ CBX500
Matrix 210™ | : ®
I_ | L | ® BM200/210 TCP/IP Ethernet Interface
I:l @ Auxiliary Serial Interface (Local Echo) (RS232)
1 @ (® External Trigger (for One Shot or Phase Mode)

Host

Figure 62 — BM200/210 TCP/IP Ethernet Interface Point-to-Point Layout
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5.1.4 Fieldbus

In this layout a single scanner functions as a Slave node on a Fieldbus network. The data is
transmitted to the Host through an accessory Fieldbus interface board installed inside the
CBX500 connection box.

Reader configuration can be accomplished through the Auxiliary interface using the VisiSet™
configuration program or Host Mode programming.

In Local Echo communication mode, data is transmitted on the RS232 auxiliary interface
independently from the Fieldbus interface selection.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

Power

CBX500

Matrix 210™

@ Fieldbus Interface (Profibus, DeviceNet, etc.)
@ Auxiliary Serial Interface (Local Echo) (RS$232)
Host ® External Trigger (for One Shot or Phase Mode)

e 1] |

Figure 63 — Fieldbus Interface Point-to-Point Layout
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5.2 ETHERNET NETWORKS

5.2.1 External Trigger Ethernet Host
(2xx-x1x models only)

In this layout, before proceeding with the connection, it is necessary to configure the reader
Ethernet parameters via VisiSet™. For further details, see “Configuration Through Ethernet’
and the Ethernet Folder in the VisiSet™ Help On Line.

When using a Local Area Network (LAN), one or more Matrix 210 2xx-x1x can be connected
to the network by using CAB-ETH-MOx cables. In the example below an External Trigger is
used which is connected through a CBX connection box.

’ ] Matrix 210™

B, o)

@!

CAB-ETH-MOx

Power

/ HOST
NETWORK

® Ethernet Interface
@ Auxiliary Serial Interface (Local Echo) (RS232) |
® External Trigger (for One Shot or Phase Mode) -/ §E8)—] =%

Figure 64 - Ethernet Network Layout
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5.3 ID-NET™ SYNCHRONIZED NETWORK
(2xx-x0x and 2xx-x1x models)

5.3.1 M/S Synchronized Serial Host

The ID-NET™ connection is used to collect data from several readers to build a multi-point or
a multi-sided reading system; there can be one master and up to 31 slaves connected
together.

The slave readers are connected together using the ID-NET™ interface. Every slave reader
must have an ID-NET™ address in the range 1-31.

The master reader is also connected to the Host on the RS232/RS485 main serial interface.
For a Master/Slave Synchronized layout the External Trigger signal is unique to the system;

there is a single reading phase and a single message from the master reader to the Host
computer. It is not necessary to bring the External Trigger signal to all the readers.

In the Master/Slave Synchronized layout the Master operating mode can only be set to
Phase Mode.

The main, auxiliary, and ID-NET™ interfaces are connected as shown in the figure below.

© ©® / L

/L
7/
Slave#l ‘Ii@i@ﬁ Slave#n |
s e )
L& & N _ | 1
Power [ Ij 1--14
Master L 1
Host @® Main Serial Interface (RS232 or RS485)
@ External Trigger
\‘- — |‘ ® ID-NET™ (up to 16 devices - practical limit)
—— “:!ﬁ

“C{aay Y
Figure 65 — ID-NET™ Synchronized Layout
The Master reader can be connected to the CBX series connection box (CBX + BM100

module) or to a QL500 having sw version 2.02.01 and later, with the advantage of the
Backup and Restore configuration function.
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If the Backup and Restore function is not required, then a QL300 or QL500 can be used to

connect the master reader.

CAB-AUX03

ID-NET™
CBL-1480-xx

CAB-AUXO03

CBL-1480-xx

Master

Slave Nodes

CBL-1490
ID-NET
Terminator

The ID-NET network must be terminated through
the internal switch of the CBX500 and inserting an
ID-NET terminator into the last QL in the network.

® BAB00 ID-NET™ Out
(@ BA400 Ext. Power
® BA500 Trigger
@®BA300 Service

Matrix 210™ Master with CBX500 + Matrix 210™ Slaves with QL150

AuX

Power
CAB-PW-EXT 2)(1)X3
= —
CBX500 4 | [ —
CAB-AUXO03 L
Figure 66 - ID-NET™ Synchronized Layout
Aux
CBL-1496
ID-NET

Terminator ID-NET™

CBL-1480-xx

P ———

|
QL300 A 1 | ~=
i |
|
|
| ps
Power m—t ] T
CAB-PW-EXT Host
\
Main Interface -
L

QL2150
5o oC
CBL-1480-xx
Slave Nodes CBL-1490
ID-NET
Terminator

The ID-NET network must be terminated
inserting an ID-NET terminator into the
QL300 (Master) and into the last QL in
the network.

Figure 67 - ID-NET™ Synchronized Layout with QL300 Serial Interface to Host
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5.3.2 M/S Synchronized TCP/IP Host

The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the
figure below.

/ /
Power 7/
/7 /
HO | S Bd o P
—— el — | 0) ‘

CBX500

® BM200/210 TCP/IP Ethernet Interface
Host @ External Trigger
® ID-NET™ (up to 16 devices - practical limit)

Figure 68 — ID-NET™ Synchronized Layout with BM200/210 TCP/IP Ethernet Interface to Host
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5.3.3 M/S Synchronized Fieldbus Host

Alternatively, the Master scanner can communicate to the Host as a Slave node on a
Fieldbus network. This requires using an accessory Fieldbus interface board installed inside
the CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of the Master
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming.

@ / /
Power 7/

Slave#1 { Slave#n |

Master

@ | I

Host
@ Fieldbus Interface

@ External Trigger (for One Shot or Phase Mode)
® ID-NET™ (up to 16 devices - practical limit)

il 1] |

Figure 69 — ID-NET™ Synchronized Layout with Fieldbus Host
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5.4 ID-NET™ MULTIDATA NETWORK
(2xx-x0x and 2xx-x1x models)

5.4.1 M/S Multidata Serial Host

For a Master/Slave Multidata layout each reader has its own reading phase independent
from the others; each single message is sent from the master reader to the Host computer.

© ®

Master Slave#l |

4o

Terminal

Power

Host ® Main Serial Interface (RS232 or RS485)

@ Auxiliary Serial Interface (Local Echo) (RS$232)

® External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 70 — ID-NET™ Multidata Layout

NOTE: The auxiliary serial interface of the slave readers can be used in
Local Echo communication mode to control any single reader (visualize
collected data) or to configure it using the VisiSet™ utility.

The ID-NET™ termination resistor switches must be set to ON only in the first
and last CBX connection box.
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5.4.2 M/S Multidata TCP/IP Host

The same configuration can be made to a Host using a TCP/IP Ethernet interface. In this
case the Master is connected to a CBX500 with BM200/210 Host Interface Module installed.

The TCP/IP Ethernet, auxiliary, and ID-NET™ interfaces are connected as shown in the

figure below.
Power ////
/7 /
CBX500
H® |[C ©°
s @
Master | i Slavein |

_ﬂ-——! l_.__-_ﬂ-——! Terminal

— ® —

Host

® BM200/210 TCP/IP Ethernet Interface

(=m TR

o

I

@ Auxiliary Serial Interface (Local Echo) (R$232)
(® External Trigger (for One Shot or Phase Mode)
@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

Figure 71 — ID-NET™ Multidata Layout with BM200/210 TCP/IP Ethernet Interface to Host

NOTE: The auxiliary serial interface of the slave readers can be used in
Local Echo communication mode to control any single reader (visualize
collected data) or to configure it using the VisiSet™ utility.

The ID-NET™ termination resistor switches must be set to ON only in the first

and last CBX connection box.
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5.4.3 M/S Multidata Fieldbus Host

Alternatively, the Master scanner can communicate to the Host as a Slave node on a
Fieldbus network. This requires using an accessory Fieldbus interface board installed inside
the CBX500 connection box.

System configuration can be accomplished through the Auxiliary interface of the Master
reader (internal CBX500 9-pin connector) using the VisiSet™ configuration program or Host
Mode programming.

Power

@ Fieldbus Interface

@ Auxiliary Serial Interface (Local Echo) (RS$232)

° Jo o 3 External Trigger (for One Shot or Phase Mode)

@ ID-NET™ (up to 32 devices, max network extension of 1000 m)

@

Figure 72 — ID-NET Multidata Layout™ with Fieldbus Host

o o [
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5.5 PASS-THROUGH

(2xx-x0x and 2xx-x1x models)
An alternative Pass-Through layout allows the more efficient ID-NET™ network to be used.
This layout is really an ID-NET Master/Slave Multidata layout which also allows each reader

(Master and Slaves) to accept input on the Auxiliary interface, for example to connect a
device such as a hand-held reader for manual code reading capability.

Each Matrix 210™ transmits its own messages plus any messages received by its Auxiliary
interface onto the ID-NET™ interface. The Master passes all messages to the Host.

When One Shot or Phase Mode operating mode is used, the reader can be activated by an
External Trigger (photoelectric sensor) when the object enters its reading zone.

O ® ya

Master Slave#?2

=
©

Power @

Host

® Main Serial Interface (RS232 or RS$485)

@ Auxiliary Serial Interface (RS232)

® External Trigger (for One Shot or Phase Mode)
@ ID-NET™

Figure 73 — Pass-Through On ID-NET™ Layout

NOTE: The reading device connected to the Host can be connected to a
Fieldbus network using a Host Interface module through a CBX500

connection box.
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5.6 USB CONNECTION
(2xx-x2x models only)

For Matrix 210 2xx-020 models, the USB connection is possible in two different layouts. The
default baud rate is 115200. To maximize data transfer you can set it up to 921600 by
configuring the reader though the Communication parameters via VisiSet™. For further
details, see the Communication Folder in the VisiSet™ Help On Line.

In a Point-to-Point layout the reader is connected to a local host through its USB cable. No
external power supply is necessary.

Matrix 210™ =

ooooo

I

Figure 74 - USB Point-to-Point Layout

One or more Matrix 210™ USB models can be connected to USB Hub. The HUB must be
able to supply 500 mA to each port.

Matrix 210™

ooooo

HOST

USB HUB

Figure 75 — Multi USB Hub Layout
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5.7 OTHER LAYOUTS
(2xx-x0x and 2xx-x1x models)

NOTE: Other backward-compatible layouts are available such as: RS232
Master/Slave, RS232 Pass Through and Multiplexer. We recommend using

the more efficient ID-NET™ network for Master/Slave or Multiplexer layouts.
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6 READING FEATURES

Focus | Field of View @ | pPpPI® Typ. 2D Code Resolution Reading
Distance mm (in) Linear and mm (mils) Distance @
MODELS mm (in) Stacked mm (in)
Code_ min. max.
Resolution
mm (mils)
Max. 0.076 (3 28 (1.10 32 (1.26
214-xxx UHD 30 16.5x10.5 1 1155 | 0,063 (2.5) ®) (1.10) (1.26)
(1.18) (0.65 x 0.41) Typ. | 013 (5) | 23 (0.91) | 38 (1.50)
Max. 0.13 (5 42 (1.65 53 (2.08
211-xxx NEAR 45 35x22 545 | 0.10 (4) ©) (1.65) (2.08)
@77) | (1.38x087) Typ. | 0.19 (7.5) | 36 (L.42) | 61 (2.40)
Max. | 0.19 (7.5) | 54 (2.13) | 90 (3.54)
212-xxx MEDIUM 2636 . 52 x fzz 380 | 0.15(6)
(2.56) | (1.97x1.26) Typ. | 0.25 (10) | 47 (1.85) | 101 (3.97)
Max. 0.25 (10 85 (3.35 135 (5.31
213k FAR 105 80 x 50 238 0.20 (8) (10) (3.35) (5.31)
(4.13) (3.15x1.97) Typ. | 0.38 (15) | 70 (2.76) | 192 (7.55)

@ @ Focus Distance

@ Ppixels per inch @ Focus Distance

®  Measurement Conditions:

e Test Chart: provided with the reader

e Still code at the center of the FOV

e Code Symbology: Data Matrix ECC 200
e Tilt Angle: 45°

e Skew Angle: 15°

e Image Processing Mode = Advanced Code Setting

e Module Size (mils) equal to the resolution of the code to read

e Image Processing Self Tuning = Enabled

e Image Processing Self Tuning Mode = Code Contrast Levels Only *
e Image Acquisition Self Tuning = Enabled (for 213-xxx models only)

* This parameter setting can increase the image processing time.
All distances are measured from the reading window to the code surface.

Depending on the code resolution, symbology and number of characters in the code, the
Reading Area can be different from the FOV.

76



READING FEATURES o

6.1 MAXIMUM LINE SPEED CALCULATION

The Exposure Time (or Shutter) parameter defines the time during which the image will be
exposed to the reader sensor to be acquired. This parameter depends heavily on the
environmental conditions (external lighting, image contrast etc.).

In general, a longer time corresponds to a lighter image but is susceptible to blurring due to
the code movement; a shorter exposure time corresponds to a darker image.

NOTE: The following considerations must be applied only when the internal
lighting system and 2D codes are used. The Maximum line speed allowed for
linear codes or postal code reading applications heavily depends on the

direction of symbol movement. When the direction of movement is parallel to
the elements of the code, the maximum speed is greater.

Assuming:

¢ X: Code Resolution (mm)
e Texp: Exposure Time (s)

e LS: Line Speed (mm/s)
The essential condition to avoid blurring effects between two adjacent elements in a dynamic
reading application is:
LSx Texp £X
The maximum (theoretical) line speed (LS) can be calculated as follows:

X/ Texp (min) = LS (max)

Texp (min) is the minimum Exposure Time value obtainable for the specific application. It
can be evaluated in static reading conditions and may depend on code printing quality,
reader position, etc.

Using the formulas previously explained it is possible to calculate the theoretical maximum
line (target) speed expected for the application, based on the maximum code resolution and
the minimum suitable Exposure Time value.

The minimum Exposure Time value depends on the Matrix reader model selected for the
application (reading distance) and on external lighting.
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The Internal Lighting Mode parameter allows to set the operating mode of the internal
lighting system. The possible values are:

Disabled: the built-in lighting system is turned off all the time. This option can be useful
only if external lighting is sufficient;

Always ON: the built-in lighting system is turned on all the time at the lowest power level.
This option is useful if the lighting system blinking (Strobed operating mode) disturbs the
operator.

Very High/High/Medium-Power Strobed: the built-in lighting system is on only during the
image exposure time. Three different lighting levels can be set.

NOTE: To avoid LED array overheating, for Power Strobed settings, the
program automatically limits the range of allowed values for the Exposure

Time parameter. Therefore, after changes to Internal Lighting Mode, recheck
Exposure Time.

CAUTION:

The maximum target speed in the application is affected by these conditions:
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Code/Background Contrast: maximum speed decreases when decreasing image
contrast (poor quality codes, reflective transparent coverings, different supports and
printing technigques).

Code Resolution: maximum speed increases when decreasing code resolution (there is
a decrement of overlapping effects between two adjacent elements).

Tilt Angle: maximum speed decreases when increasing Tilt angle (from 0 to 45 degrees).
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7/ SOFTWARE CONFIGURATION

Software configuration of your Matrix 210™ for static reading or simple code reading
applications can be accomplished by the Rapid Configuration procedure using the X-
PRESS™ HMI (which requires no external configuration program) or by using the VisiSet™
Setup Wizard for easy setup. These procedures are described in chapter 1.

For other applications use VisiSet™ through the reader serial ports.

NOTE: For Ethernet applications, connections to VisiSet™ can be made
directly through the Ethernet port of the reader (Ethernet models only), or
QL500 or BM2x0 Host Interface module. See the "Configuration Through
Ethernet" page in the VisiSet™ Help On-Line, or the "Matrix Family Setup

Procedure Using Programming Barcodes" document on the VisiSet™ Mini-
DVD (downloaded ISO file or mini-DVD accessory).

7.1 VISISET™ SYSTEM REQUIREMENTS

To install and run VisiSet™ you should have a Laptop or PC that meets or exceeds the
following:

e Pentium processor

e Windows 98/2000, NT 4.0, XP, Vista, 7 or 8

e 32 MB Ram

e 5 MB free HD space

e one free RS232 serial port with 115 Kbaud (or USB-Serial Adapter)

e one Ethernet TCP/IP port

e Video Adapter (1024 x 768) or better using more than 256 colors

7.2 INSTALLING VISISET™

To install VisiSet™, proceed as follows:

1. Turn on the Laptop or PC that will be used for configuration (connected to the Matrix
210™ communication ports).

2. After Windows finishes booting, launch the VisiSet™ installation from the downloaded
software package or accessory mini-DVD.

3. Follow the instructions in the installation procedure.
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7.3 STARTUP

After completing the mechanical and electrical connections to Matrix 210™, you can begin
software configuration as follows:

1. Power on the Matrix 210™ reader. Wait for the reader startup. The system bootstrap
requires a few seconds to be completed. The reader automatically enters Run Mode.

Run the VisiSet™ program.

Press Connect on the VisiSet™ menu bar. The PC will automatically connect to the
Matrix 210™ reader.

Upon connection, Matrix 210™ exits Run Mode and displays the Main Menu on VisiSet™
with all the commands necessary to monitor your reader's performance. You can select
these commands using the mouse or by pressing the key corresponding to the letter
shown on the button. See Figure 76.

(4 visiSet

File Edit Connect Disconnect Device Options Tools Help

MATH MENU
Device: Matrix 210

M.Setup\Mzard Model: 211-110
Communication Port: Auxiliary

F. Calibration Tool

Standard Application Program for Matrix Family Rel. 6.10
V. Symbol Verification |

A. Run Mode

B. Capture Image

C. Decode Last Image

D. View Last Image

E. Download Last Image

H. Upload Bitmap Image
Terminal

Q. Image Buffer Window

3. Button Function Menu

Commands Status Bar
Window

Connection: Def_Matrix on 172.27.101.81 Reader Status: OFF LINE MODE Log : OFF

Figure 76 - Main Window
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7.3.1 VisiSet™ Options

The Options item from the VisiSet™ menu (see Figure 76) presents a window allowing you
to configure:

— the logging function (Log)
— VisiSet™ window properties (Environment)

— VisiSet™ communication channel (Communication)

Save Exit

Log l Environment| Communication |

Log options

Log File Name

;.\log‘bd Browse

Default Open State Delete old log file
~ OFF " ON « OFF " ON

Log Print Level
& Evenything

" Only Codes

 Only Erors

Exit

Figure 77 - Options - Log

Ha VisiSet Options @

Save Exit

Log Environment I Communication ]

Font & Background

Change Font

Restore Factory Settings

Change Background

Save Exit

Figure 78 - Options - Environment
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Save Exit

Log | Enviranment Communication |

Communication Channel
¢ Serial port ~ USB " Ethemet
Autoconnect ports Starting port configuration for auto search
Port Baud rate (bps) Stop bits
v [comi <] oM c 2400 i
- C
v |COM2 & COM2 b ;lﬁgg o
[~ |COM3 ~
& © 18200
COM4 ~
r C o 38400 Parity
" 57600
& None
115200
230400 " Even
460800
IS " Odd

Exit

Figure 79 - Options — Communication

Save Exit

Communication Channel
" Serial port

Log ]Environment Communi:ationl

« USB

Device Ethemet Channel Address

& Ethernet

IP Address 172.16.11.12
IP Port Number 3 File IP Port Number .
Stop Device Network Searching l
Device ID IP Address |MAC Number R
MATRIX 172.16.11.12 0007BED04359 =
MATRIX 172.16.11.15 0007be003fcd
MATRIX 172.16.11.16 0007BEDO3E3C
MATRIX 172.16.11.171 0007BED02DYE 3

i

Figure 80 - Options — Communication: Ethernet
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7.4 CONFIGURATION

Once connected to Matrix 210™ as described in par. 7.3, you can modify the configuration
parameters as follows:

1.

6.

Press the Calibration Tool button from the Main Menu. Matrix 210™ will download its
permanent memory configuration parameters with the default values (if it is the first time)
to VisiSet™. The Calibration Tool window will be displayed together with the Parameter
Setup window working in Interactive Mode (see par. 7.4.1 and par. 7.4.3).

Edit the Matrix 210™ configuration parameters according to your application
requirements.

Use the Calibration Tool to fine tune the reading performance. See par. 7.4.3.

Close the Calibration Tool window and disable the Interactive Mode by pressing the
interactive button.

Save the new configuration to the reader permanent memory by pressing the Send
button.

NOTE: Especially for lengthy configurations in Interactive Mode, it is always
good practice to periodically send the configuration to Permanent Memory to

avoid losing the configuration in Temporary Memory.

Close the Parameter Setup window and press Disconnect on the VisiSet™ menu bar
(see Figure 76) or launch Run Mode from the VisiSet™ Main menu.

Disconnect exits closing communication between Matrix 210™ and VisiSet™, and
causes Matrix 210™ to enter Run Mode. The disconnected reader serial port is now
available.

Run command does not close communication between Matrix 210™ and VisiSet™,
and causes Matrix 210™ to enter Run Mode. In this case the reader output messages
are displayed on the VisiSet™ terminal and the statistics are displayed in the
Statistics window (Statistics enabled).
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7.4.1 Edit Reader Parameters

The Parameter Setup window displays the configuration parameters grouped in a series of
folders. Each parameter can be modified by selecting a different item from the prescribed list
in the box, or by typing new values directly into the parameter box.

By right clicking the mouse when positioned over the name of a specific Parameter or Group,
a pop-up menu appears allowing you to directly manage that particular parameter or group.

You can View the Selected Value for each parameter.
You can Restore the Default Value of each parameter or of all the parameters of a group.

Get Properties gives information about the parameter in the form of a pop-up hint that
describes the default value and the range/list of valid values.

The Short Help gives information about the parameter in the form of a pop-up hint.

& Parameter Setup

File Device Mode
Get | Send | SendDefaults | | [ Permanent | interactive |
2D Codes ] 1D Codes I Postal Codes I Image Processing I Miscellaneous l
Reading System Layout I CBX Gateway ] Display I Diagnostics ]
Operating Modes ] Calibr ; : Ds And Keypad ]
Data Collection I Match C Parameter Group Communication |
CODE COLLECTION 7
Number Of Codes / 1
Code Collection Filters / Disabled
DATA FORMAT 7
Code Field Justification Disabled
Code Field [Cutting Disabled
N 24y
5 Parameter ————  vView Selected Yalue
Statistics Field Separator String Restore Default Value Single group/parameter
Statistics Field Format Get Properties Tﬁgﬁ?g?&gt
Symbology Identifiers Short Help
STATISTICS
Status Disabled

Figure 81 - Editing Parameters
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Parameters to verify/modify:

O Operating Mode Sets the parameters which customize the reader operating mode
starting from three main modes:

One Shot: acquires a single image based on the selected value
for the Acquisition Trigger and Acquisition Trigger Delay.

Continuous: continuously acquires images with a rate up to the
maximum allowable frame rate per second for the given sensor
depending on the decoding time and the Region of Interest
settings.

Phase Mode: acquires images during the reading phase
depending on the selected value for the Acquisition Trigger and
Acquisition Trigger Delay. The Reading Phase-ON and Reading
Phase-OFF events mark respectively the beginning and end of
the reading phase.

U Calibration Calibrates the acquisition parameters to maximize the reading
performance (see par. 7.4.3).

U Communication Configures the parameters relative to each serial port regarding
the transmission, message formatting and string receiving.

Any change to the VisiSet™ communication port parameters
(baud rate, data bits, etc.) is effective as soon as the reader is
disconnected from VisiSet™.

U Reading System Layout Allows configuring the device according to the desired layout:
Standalone, ID-NET™ or Master/Slave RS232

U WebSentinel Enables the Ethernet WebSentinel Agent for communication with
the Datalogic WebSentinel™ plant array monitor.

O Ethernet For (2xx-x1x models) Sets the parameters related to the on-
board Ethernet interface and to its communication channels.
Supports application protocols: TCP/IP, EtherNet/IP, Profinet 10
and Modbus TCP.

U CBX Gateway Sets the parameters related to the External Host Interface
Module through the CBX500 and to its communication channels.

O Image Processing Sets the image processing parameters shared by all available
symbologies.

QO 1D & 2D, Postal Codes Sets the characteristics of the code symbologies to be read.

O Data Collection Defines the code-collection parameters and the output message
format.

U Digital I/O Configures the reader input/output parameters.

U Match Code Allows setting a user-defined code and relative parameters to
which the read code will be compared (matched).

U Miscellaneous Sets the reader name and the saved image format.

U Symbol Verification Sets the parameters relative to the various specifications in the
Standards which regulate code validation.

U LEDs And Keypad Sets the X-PRESS™ LED and Keypad parameters related to their

selected Functions: Beeper, Green Spot, Positioning, etc.

U Display Sets the Display language and Layout of the BM150 Display
when using the CBX500 connection box.

U Diagnostics Enables various diagnostic messages, formatting and actions.
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When all the configuration parameters are set correctly, save them to the Matrix 210™
reader by pressing the Send button. See Figure 81.

For successive configuration of other readers or for backup/archive copies, it is possible to
save the configuration onto your PC by selecting the Save Configuration File option from
the File menu.

From the File menu, you can also Save Configuration As Text File for a human readable
version.

Load Configuration File (available in the File menu) allows you to configure a reader from a
previously saved configuration file (.ini).

7.4.2 Send Configuration Options

The device parameters are divided into two main classes, Configuration and Environmental
which are effected differently by the Send Configuration and Send Default Configuration
commands.

Configuration Parameters regard parameters that are specific to the device. These
parameters are influenced by the Send Configuration and Send Default Configuration
commands, that is they are overwritten by these commands. The same parameters are
modified by the following "Send Configuration with Options" and "Send Default Configuration
with Options" dialogs from the Device Menu:

5 Parameter Setup

File MRS Mode
' Get Configuration : =
( nt | Interactive |
" Send Configuration » L
2D Send Configuration With Options » fing | Miscellaneous |
Dy : ; ] Communication ]
A Send Default Configuration » I Di i ]
Send Default Configuration With Options y ! e
Op LEDs &nd Keypad |
Select MNext Parameter Ctrl+F1
Select Previous Parameter Ctrl+F2
Reading Phase ON Ext. Trig. Leading Edge
Acquisition Trigger Continuous
Acquisition Trigger Status Always Enabled
Reading Phase OFF Ext. Trig. Trailing Edage
Image Acquisition Buffer Size 2
ACQUISITION TRIGGER DELAY 1
Status Disabled
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Environmental Parameters regard the device Identity and Position in a Network (ID-NET™,
Master/Slave RS232, MUX 32, Ethernet) and are not influenced by the "Send Default
Configuration" and "Send Configuration" commands. This allows individual devices to be
configured differently without affecting their recognized position in the network.

The following is a list of the Environmental Parameters:

READING SYSTEM LAYOUT
- Device Network Setting
- Number of Slaves

DEVICE NETWORK SETTINGS

- Topology Role

- ID-NET Slave Address

- Network Baud Rate

- Acquisition Trigger String (available only in Multidata configuration)
- Reading Phase ON String  (available only in Multidata configuration)
- Reading Phase OFF String (available only in Multidata configuration)

- Header String (available only in Slave Multidata configuration)
- Terminator String (available only in Slave Multidata configuration)
- Link Failure String (available only in Master Synchronized configuration)

- Link Failure Timeout (ms)  (available only in Master Synchronized configuration)

EXPECTED SLAVE DEVICES
- Status

- Device Description

- Device Network Name

MAIN PORT
- Communication Protocol
- Multidrop Address

ETHERNET SYSTEM (on-board)
- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

- DNS1 Address
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HOST INTERFACE
- Host Interface Type

CBX ETHERNET SYSTEM (CBX with Host Interface Modules)

- Status

- DHCP Client

- IP Address

- Subnet Mask

- Gateway Address

PROFIBUS
- Node Address

DEVICENET
- Node Address

ETHERNET-IP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

PROFINET IO

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

CANOPEN
- Node Address

CC-LINK
- Node Address

MODBUS TCP

- IP Addressing Mode
- IP Address

- Subnet Mask

- Gateway Address

MISCELLANEOUS
- Reader Name

- User Name

- Line Name
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For device replacement it is necessary to send the previously saved configuration (both
Configuration and Environmental parameters) to the new device. To do this select "Send
Configuration with Options" from the Device Menu and check the Environmental Parameters

checkbox:
&t send Options @

Do you wantto send current configuration to device ?

Parameter Selection
F

v Environment Parameters:

o Ves I X No

In order to return a device to its absolute default parameters including Environmental

parameters, the following Send Default Configuration with Options" dialog must be used:

(4 Send Defaults Options @

Do you want to restore default configuration to dewvice ?

-Parameter Selection
I"’:

v Environment Parameters

o Yes I X No
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7.4.3 Calibration

VisiSet™ provides a Calibration Tool to maximize the reading performance by tuning the
acquisition parameters and the time of the delayed triggers.

By selecting the Calibration Tool from the VisiSet™ Main Menu (F), the following window

appears together with the Parameter Setup window:

EB Calibration Tool

Top.Left

Acquisition Setting:
Exposure Time [x10us):
Gain:

- Décoding Results
Symbology:
Code Data:
Code Center:
Code Orientation:

~Image Lighting Quality

Exposure Index:

Stop Image Acquisition
(¢ Disabled

(" After Any Capture
" OnMNoDecode

(" OnDecode

~Screen Mode

« D g‘:

~Image Acquisition Information

35
14

Data Matrix ECC 200
Datalogic 2D Code Reader
[X.Y])=[375.242)

a8

' J

(" Code Position Only
" Camera Mode

Bottom,Right s |

Self Tuning: Disabled

: l =1
Selected Code: 1 =
Quality Index:

Lighting Index:

Underexposed 0K Overexposed

i~ Statistical information on the last 10 samples THR/RR

m

Decode %:

Close |

Figure 82 - Calibration OK

This tool provides a "real-time" image display while Matrix 210™ is reading. It also gives
immediate results on the performance of the installed Matrix 210™ reader.

If Self Tuning is enabled, the Calibration Tool window indicates the region where the
calibration algorithm is performed: it is within the central box delimited by four red dots.

NOTE: If using Region Of Interest windowing, some or all of the four red
dots delimiting the calibration algorithm area may be located outside the

L

VisiSet™ display area (not visible).
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The Parameter Setup window works in Interactive Mode in order to cause each parameter
setting to be immediately effective.

memory, you must first close the Calibration Tool window. Then, you must
disable the Interactive Mode and select the Permanent Memory option from
the Send Configuration item in the Device menu.

@ NOTE: If you want to save the temporary configuration to permanent

The following examples show some of the typical conditions occurring during the installation:

Under-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. increase the Exposure Time
2. increase the Gain

NOTE: In general, a longer exposure time corresponds to a lighter image but
is susceptible to blurring due to code movement. Exposure time is also
limited by the Internal Lighting mode parameter. Longer exposure times
can be set if the power strobe level is lowered.

High gain settings may produce a grainy image that may affect the decoding
process.

& calibration Tool %) | & parameter Setup
g el Stop Image Acquisition File Device Mode
& Disabled T
" After Any Capture Get | Send | Send Defaults I ‘ Permanent | ‘ Interactive |
" OnMNo Decode -
" OnDecode Postal Codes ] Image Processing l Miscellaneous ] Data Collection l
Screen Mode Match Code I Symbol Verification I Communication I Diagnostics I
@ Decoded Image Operating Modes Calibration I LEDs And Keypad I 2D Codes ] 1D Codes ]
" Code Position Only IMAGE ACQUISITION SETTING 1
~
EomsaMad Status Enabled
Tigger med | Self Tuning Disabled
i Internal Lighting Mode High-Power Strobed
B Exposure Time (x100us) 10
Bottom, Right Gain 10
Image Acquisition Information - -
Acquisition Setting: 1 Self Tuning: Disabled Gain Increasing ¥
Exposure Time (x10us): 100 Image Polarity Inversion Disabled
Gain: 10 Region Of Interest: Top 0
Decoding Results o Region Of Interest: Bottom 479
Symbology: Data Matrix ECC 200 Selected Code: = S
sl = é“x RS L | Region Of Interest: Left 0
Code Data: Datalogic 2D Code Reader - -
Code Center: (X.Y]=(396,238) Region Of Interest: Right 751
Code Orientation: 89 Quality Index: Image Filter Disabled

Image Lighting Quality

Exposure Index: Lighting Index:
Underexposed 0K Overexposed

Statistical information on the last 10 samples TR/RX

Figure 83 - Example Under Exposure: Too Dark
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Over-exposure:

To correct this result it is recommended to change the following parameters in their order of
appearance:

1. decrease the Gain
2. decrease the Exposure Time

£ Parameter Setup

X

Jas et Stop Image Acquisition File Device Mode

@ Disabled T T
€ After Any Capture Get | Send | S lts | ‘ F | Interactive |
(" OnNoDecode -
" OnDecode Postal Codes ] Image Processing [ Miscellaneous ] Data Collection l
Screen Mode Match Code I Symbol Verification I Communication I Diagnostics I
@ Decoded Image Operating Modes Calibration I LEDs And Keypad I 2D Codes ] 1D Codes 1
" Code Position Only IMAGE ACQUISITION SETTING 1
{ Cpakioe Status Enabled

| Self Tuning Disabled

i Internal Lighting Mode High-Power Strobed
- ] Exposure Time (x100us) 40
Bottom, Right 12

Gain

Image Acquisition Information

Acauisiion Setting: 1 Sel Tuning: Disabled Gain Increasing ¥l
Exposure Time [x10us): 400 Image Polarity Inversion Disabled
Gain: 12 Region Of Interest: Top 0
Decoding Results 7 Region Of Interest: Bottom 479
Symbology: Data Matrix ECC 200 Selected Code: 1 ~ S

i o ? o SRR e = Region Of Interest: Left 0
Code Data: Datalogic 2D Code Reader - -
Code Conter: (X.Y)=(395,237) Reagion Of Interest: Right 751
Code Orientation: 29 Quality Index: Image Filter Disabled

Image Lighting Quality

Exposure Index: Lighting Index: A
Underexposed oK Overexposed

Statistical information on the last 10 samples TXR/BX

Figure 84 - Example Over Exposure: Too Light
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Moving code out of the Field of View:

To correct this result and have the code completely visible in F.O.V., it is possible to follow

one or both the procedures listed below:
reposition the reader

use the Acquisition Trigger Delay by tuning the Delay Time (x100us)

& Parameter Setup E]\ -

Decode %:

[

Toplet Stop Image Acquisition File Mode
& Disabled
" After Any Capture Get I Send I Send Defaults l Permanent ' ’ Interactive ‘
" OnMNoDecode -
" OnDecode Postal Codes I Image Processing I Miscellaneous I Data Collection I
[~Screen Mode Match Code I Symbol Verification ] Communication I Diagnostics I
& Decoded Image Operating Modes Calibration ] LEDs AndKeypad | 2D Codes | 1D Codes |
(" Code Position Only IMAGE ACQUISITION SETTING 1
8
CongeMods Status Enabled
Self Tuning Disabled
Internal Lighting Mode High-Power Strobed
Exposure Time [#100us) 16
Bottom,Right Gain 12
~Image Acquisition Information - -
Acquisition Setting: 1 Self Tuning: Disabled Gain Increasmg ¥l
Exposure Time (x10us): 160 Image Polarity Inversion Disabled
Gain: 12 Region Of Interest: Top 0
- Decoding Result 7 Region Of Interest: Battom 479
Symbology: Data Matix ECC 200 Selected Code: 1 = A
= 2
Code Data: Datalogic 2D Code Reader HegonDiincies L?" 0
ok Eonier (X.Y)=(559,223) Region Of Interest: Right 751
Code Orientation: 92 Quality Index: ‘ Image Filter Disabled
Image Lighting Quality |
Exposure Index: Lighting Index:
Underexposed oK Overexposed
[~ Statistical information on the last 10 samples “TX/RX -

Figure 85 - Example out of FOV
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7.4.4 Multi Image Acquisition Settings

When controlled variable conditions occur in the application, Multiple Image Acquisition
Settings (up to 10), can be defined to create a database of parameter groups that handle
each specific application condition. This database of pre-defined settings functions cyclically
and therefore automatically improves system flexibility and readiness.

For example, an application may have two stable but different lighting conditions which
require different lighting options. One Image Acquisition Setting could enable and use the
internal illuminator and a second setting could disable Internal Lighting to use external
lighting. These two groups will be used cyclically on each acquisition in order to automatically
capture the correctly lighted image.

Image Acquisition Settings are found in the VisiSet™ Calibration parameter setup menu.
By selecting a different number and enabling its Status you can define the parameters for a
new group.

7.4.5 Run Time Self Tuning (RTST)

Run Time Self-Tuning (RTST) increases Matrix’s flexibility in the presence of uncontrolled
variable conditions (lighting, code contrast, etc.) by automatically adjusting its acquisition
parameters.

Self Tuning Calibration

In the Calibration parameter setup menu, the Self Tuning parameters manage the Image
Acquisition Setting parameters dynamically. Self Tuning provides automatic adjustment in
run time of different acquisition parameters (Exposure Time and/or Gain) for each captured
image based on calculations performed on previous acquisitions. These dynamic settings will
be used instead of the static settings saved in memory.

From fo
Not Readable Readable

For more details see the Matrix 210™ Help On-Line.

Self Tuning Image Processing

In the Image Processing parameter setup menu, the Self Tuning parameters manage the
Image Processing and Symbology related parameters. They perform different processing
attempts on the same captured image according to the selected Self Tuning Mode parameter
value: (Symbologies Only, Processing Modes Only, Decoding Methods Only, Code Contrast
Levels Only, Image Mirroring Only, or General Purpose).

For more details see the Matrix 210™ Help On-Line.
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7.4.6 Region Of Interest Windowing

In order to satisfy very high throughput applications, higher frame rates can be achieved
using the powerful Region Of Interest Windowing parameters in the Calibration parameter
setup menu.

Region Of Interest Windowing allows defining a region or window within the reader FOV.
The Top, Bottom, Left and Right parameters allow to precisely define the image window to
be processed, visualized and saved.

In Matrix 210™ the frame rate is dependent on the number of rows and columns in the
defined window.

The smaller the window, the lower the frame period and consequently the higher the frame
rate. In general the Image Processing time can be reduced by reducing the window
dimensions.

M calibration Tool o= EH Parameter Setup E]E @
Top Left - . —

Stop Image Acquisition File o Mode
¢ Disabled P T
" After Any Capture Gel | Send [ Send Defaults | Permanent I Interactive l
" OnMNoDecode
" OnDecode Postal Codes I Image Processing ] Miscellaneous ] Data Collection |
Screen Made Match Code I Symbol Verification I Communication ] Diagnostics I
@ Decoded Image Operating Modes Calibration I LEDs And Keypad [ 2D Codes ] 1D Codes ]
" Code Position Only IMAGE ACQUISITION SETTING 1
" Camera Mode Status Enabled

[ Self Tuning Disabled

& o Intemal Lighting Mode High-Power Strobed
. Exposure Time [x100us) 14
Bottom Right 20

Gain

Image Acquisition Information

Acquisition Setting: 1 Self Tuning: Disabled Gain Increasing %1
Exposure Time (x10us): 140 Image Polarity Inversion Disabled
Gain: 20 Region Of Interest: Top 100
Decoding Results 7 Region Of Interest: Bottom 400
Symbology: Code 33 Selected Code: I = _

v 7
G e Region Of Interest: Left 150
Eode Ganier (X.Y)=(378,242) Reagion Of Interest: Right 600
Code Orientation: 180

Image Lighting Quality

Exposure Index: Lighting Index:
Underexposed oK Overexposed

Statistical information on the last 10 samples TRIRX

dots delimiting the calibration algorithm area may be located outside the

@ NOTE: If using Region Of Interest windowing, some or all of the four red
VisiSet™ display area (not visible).
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7.4.7 Direct Part Marking Applications

Decoding Method: Direct Marking

For Data Matrix and QR code the Decoding Method parameter selects the decoding
algorithm according to the printing/marking technique used to create the symbol and on the
overall printing/marking quality. The Direct Marking selection improves the decode rate for
low quality Direct Part Mark codes and in general for Direct Part Mark codes with dot peening

type module shapes.

Washed out and Axial Dot Peening On

1 ; Low Contrast
Distortion
Scratched Surface Problem

Axial ,
distortion

Background Marked On Curved
Problems Shiny Surface

:\: \ T s
Low contrast,
noisy background

Half moon effects

Shiny surface,
noisy background

All the previous examples are successfully read selecting the Direct Marking Decoding
Method.
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Image Filter

Sets the filter to be applied to the image before being processed. This parameter can be
used to successfully decode particular ink-spread printed codes (i.e. direct part mark codes).

A different filter can be applied to each Image Acquisition Setting.

The Erode Filter enlarges the image dark zones to increase readability.

Before - No Read After - Readable
Erode

The Dilate Filter enlarges the image white zones to increase readability.

Before - No Read After - Readable
Dilate

The Close filter eliminates dark areas (defects) in the white zones of the image.

Before - No Read After - Readable

Close
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The Open filter eliminates white areas (defects) in the dark zones of the image.

Before - No Read After - Readable
Open

The Contrast Stretching filter maximizes image contrast.

ahie

Before - No Read After - Readable
Contrast Stretching
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The Histogram Equalization filter makes the gray level distribution uniform.

Before - No Read After - Readable

Histogram Equalization

The Smoothing filter deletes small (insignificant) details in the center of the image.

Before - No Read After - Readable
Smoothing

The Sharpening filter improves out of focus images.

Before - No Read After - Readable
Sharpening
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The Deblurring filter improves blurred images.

Before - No Read After - Readable
Deblurring

The Black Enhancement filter produces a nonlinear increase in the black level for light
images.

Before - No Read After - Readable

Black Enhancement

The White Enhancement filter produces a nonlinear increase in the white level for dark
images.

AN &

248348 %" o
5\'?'.'..-..

Before - No Read After - Readable

White Enhancement
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7.5 IMAGE CAPTURE AND DECODING

By using the Capture Image and Decode Last Image functions from the VisiSet™ Main
menu, you can get information about the image decodable codes in terms of Symbology,
encoded Data, Position and Orientation, Decode Time and Code Quality Assessment Metrics.

EBX

File Edit Connect Disconnect Device Options Tools Help

MATH MENU Image captured (752x480) using Acguisition Setting #1 (Self Tuning
disabled) .

M. Setup Wizard dhkkkkkkk Ak kkddk Tmage Processing started (#1):

F. Calibration Tool Hew Code (#4.1):
Symbology: Data Matrix ECC 200
V. Symbol Verification Humber of Characters: 24
Code Center Position: 547 ,330)
A. Run Mode Pixel per Element: 6.
Module Size: 12.3 mils @ Focus Distance
B. Capture Image Decoding Time (ms): 10

Code Orientation: 276°

C. Decode Last Image Code Bounds: TL[618,251] TR[632,402] BL[465,257] BR[475,407]

D. View Last Image

E. Download Last Image

Symbol Size: 20x20
Code Quality Index: 100%
ISO-IEC 16022-18004 Quality Indicators:

Overall Grade

Symbol Contrast

Print Growth

Axial Hon Uniformity

Unused Error Correction: & (100%)
0. Image Buffer Data: Datalogic 2D Code Reader

H. Upload Bitmap lmage

G. Store Match Code

3. Button Function Menu Image Exposure Quality: 100%
Image Processing Time (ms): 12

KkAAARAAAAKAAAAY Tmage Processing completed (#1).

Connection: C08D12005 on COM1 at 115200,M,8,1 Reader Status: OFF LINE MODE Log : OFF

Figure 86 - Capture and Decoding Functions

7.6 STATISTICS

Statistics on the reading performance can be viewed by enabling the Statistics parameter
and selecting the View Statistics item in the File menu. One of three different windows
appears depending on the operating mode.

Refer to the VisiSet™ Help On Line for more details.

Total Samples

Acquisition Counter: 1000
Complete Read Counter: 1000
Complete Reads (%): 100.00

Last Samples

Acquisition Counter: 20
Complete Read Counter: 20
Complete Reads (%]): 100.00

Reading Performance

Mean Decoding Time [ms): 22
Max Decoding Time (ms): 22
Frame Rate (Images/s): 14

Last Decoded Code
Symbology: Data Matrix ECC 200
Code Data: Datalogic 2D Code Reader

Reset

Figure 87 - Code Statistics
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8 MAINTENANCE

8.1 CLEANING

Clean the reading window (see
Figure A, 1) periodically for continued correct operation of the reader.

Dust, dirt, etc. on the window may alter the reading performance.
Repeat the operation frequently in particularly dirty environments.

Use soft material and alcohol to clean the window and avoid any abrasive substances.
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9 TROUBLESHOOTING

9.1 GENERAL GUIDELINES

e When wiring the device, pay careful attention to the signal name (acronym) on the
CBX100/500 spring clamp connectors (chp. 4). If you are connecting directly to the
Matrix 210™ 25-pin male D-sub connector pay attention to the pin number of the signals
(chp. Error! Reference source not found.).

o If you need information about a certain reader parameter you can refer to the VisiSet™
program help files. Either connect the device and select the parameter you're interested in
by pressing the F1 key, or select Help>Paramters Help from the command menu.

o If you're unable to fix the problem and you’re going to contact your local Datalogic office or
Datalogic Partner or ARC, we suggest providing (if possible): Application Program version,
Parameter Configuration file, Serial Number and Order Number of your reader. You can
get this information while VisiSet™ is connected to the reader: the Application Program
version is shown in the Terminal Window; the Parameter Configuration can be saved to an
.ini file applying the File>Save Configuration File command in the Parameter Setup
window; Serial Number and Order Number can be obtained by applying the respective
command in the Tools menu.

TROUBLESHOOTING GUIDE

Problem Suggestion

Power ON: ¢ Is power connected?

the “POWER” LED is not lit. ¢ [f using a power adapter (like PG6000), is it connected
to wall outlet?

 If using rail power, does rail have power?

¢ |f using CBX, does it have power (check switch and
LED)?

e Check if you are referring to the 25-pin connector or to
the CBX spring clamp connectors.

o Measure Voltage either at pin 13 and pin 25 (for 25-pin
connector) or at spring clamp Vdc and GND (for CBX).

One Shot or Phase Mode e Check if you are referring to the 25-pin connector or to
using the Input 1 (External the CBX spring clamp connectors.

Trigger) or Input 2: ¢ Is the sensor connected to the Input 1 or Input 2?

the "TRIGGER” LED is not e |Is power supplied to the photo sensor?

blinking while the External o For NPN configuration, is power supplied to one of the
Trigger is switching. two 11 or 12 signals (A or B)?

o For PNP configuration, is one of the two I1 or 12 signals
grounded (A or B)?

e Are the photo sensor LEDS (if any) working correctly?

¢ Is the sensor/reflector system aligned (if present)?

¢ In the Digital I/O folder check the EXTERNAL
TRIGGER or INPUT 2\Debounce Filter parameter
setting.

¢ In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

One Shot or Phase Mode
using serial trigger source:
the "TRIGGER” LED is not
blinking.

In the Operating Mode folder check the settings for
Reading Phase-ON, Acquisition Trigger and
Reading Phase-OFF parameters.

Are the COM port parameters (Baud Rate, Parity, Data
Bits, Stop Bits, Handshake) correctly assigned?

In the communication folder, check the settings of
Reading Phase-ON String, Acquisition Trigger
String and Reading Phase-OFF String parameters.

Is the serial trigger source correctly connected?

Phase Mode:

the "TRIGGER" LED is
correctly blinking but no image
is displayed in VisiSet™
Calibration Tool window.

Is the Phase frequency lower than the maximum frame
rate?

Continuous Mode:
the "TRIGGER” LED is not
blinking.

Verify the correct software configuration settings.

Any Operating Mode:

the "TRIGGER” LED is
correctly blinking but no result
is transmitted by the reader at
the end of the reading phase
collection.

In the Data Collection folder check the settings for the
CODE COLLECTION, DATA FORMAT and
STATISTICS parameter groups.

Image not clear:

Verify the Focus procedure

Image focused but not
decoded:

Verify the Calibrate Image Density prodcedure.

Reading:
the reader always transmits
the No Read Message

Run the Rapid Configuration procedure in chapter 1.
Position the reader as described in par. 3.3 and through
the VisiSet™ Calibration Tool:

Tune the ACQUISITION TRIGGER DELAY, if the
moving code is out of the reader field of view;

Set the Continuous Operating Mode if no external
trigger source is available;

Tune the IMAGE ACQUISITION SETTING to
improve the code image quality;

Check the parameter setting in Decoding,

2D Codes, 1D Codes, and Postal Codes folders;
View the full resolution code image to check the
printing or marking quality.

Communication:
reader is not transmitting
anything to the host.

Is the serial cable wiring correct?

If using CBX, be sure the RS485 termination switch is
OFF.

Are the host serial port settings the same as the reader
serial port settings?

In VisiSet™ Digital I/O folder, "COM" LED can be
configured to indicate MAIN COM port TX or MAIN
COM port RX.
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TROUBLESHOOTING GUIDE

Problem

Suggestion

Communication:

data transferred to the host
are incorrect, corrupted or
incomplete.

Are the host serial port settings the same as the reader

serial port settings?

In VisiSet™ Communication folder check the settings of

Header and Terminator String parameters.

In VisiSet™ Data Collection folder, check the settings of
DATA FORMAT parameter group.

How do | obtain my reader
Serial Number?

The reader Serial Number consists of 9 characters: one
letter, 2 numbers, another letter followed by 5 numbers.
The reader Serial Number is printed on a label that is
affixed on the bottom case near the reading window.
The Serial Number can also be obtained by selecting
Tools/Get Reader Serial Number from the command
menu in VisiSet™. A dedicated window will appear.

How do | obtain my reader
Order Number?

The reader Order Number consists of 9 numbers.

The reader Order Number can be obtained by selecting
the Tools/Get Reader Order Number from the command
menu in VisiSet™. A dedicated window will appear.
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10 TECHNICAL FEATURES

ELECTRICAL FEATURES Matrix 210 2xx-x0x Matrix 210 2xx-x1x Matrix 210 2xx-x2x

Power

Supply Voltage 10 to 30 Vdc 10 to 30 Vdc 5 Vdc

Consumption 03510 0.13A,3.9W 0410 0.15A,45Wmax |05A, 2.5W max
max.
0.16 A@ 24 V. 0.18A @24V

Communication Interfaces

Main USB 2.0 up to 921600

- RS232 2400 to 115200 bit/s 2400 to 115200 bit/s bit/s

- RS485 full-duplex 2400 to 115200 bit/s 2400 to 115200 bit/s

- RS485 half-duplex 2400 to 115200 bit/s 2400 to 115200 bit/s

Auxiliary - RS232 2400 to 115200 hit/s 2400 to 115200 bit/s

ID-NET™ Up to 1MBaud Up to 1MBaud

Ethernet® 10/100 Mbit/s

Inputs Opto-coupled and polarity | Opto-coupled and polarity

Input 1 (External Trigger) and Input 2 insensitive insensitive

Max. Voltage 30 Vdc 30 Vdc

Max. Input Current 10 mA 10 mA

Outputs

Output 1 and Output 2 Opto-coupled Opto-coupled

Vout (ILoad = 0 MA) Max. 30 Vdc 30 Vdc

Vout (ILoad = 10 MA) Max. 1.8 vdc 1.8 vdc

Pb = Vout X lLoad Max. 170 mwW 170 mwW

OPTICAL FEATURES

Image Sensor CMOS sensor with Global Shutter

Image Format WVGA (752x480)

Frame Rate up to 60 frames/sec. @ full window size

Pitch +35°

Tilt 0° - 360°

Lighting System Internal LED llluminator to EN 62471

ENVIRONMENTAL FEATURES

Operating Temperature3 0t0 50 °C (320 122 °F)

Storage Temperature -20 to 70 °C (-4 to 158 °F)

Max. Humidity 90% non condensing

Vibration Resistance 14 mm @ 2to 10 Hz; 1.5 mm @ 13 to 55 Hz;
EN 60068-2-6 2 g @ 70 to 200 Hz; 2 hours on each axis
Bump Resistance 30g; 6 ms;

EN 60068-2-29 5000 shocks on each axis

Shock Resistance 30g; 11 ms;

EN 60068-2-27 3 shocks on each axis

Protection Class IP65

EN 60529

2 for Ethernet models only; supports application protocols: TCP/IP, EtherNet/IP, Profinet-IO, Modbus TCP
8 high ambient temperature applications should use metal mounting bracket for heat dissipation
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PHYSICAL FEATURES

Matrix 210 2xx-1xx

Matrix 210 2xx-0xx

Dimensions

50 x 25 x 45 mm
(1.97 x 0.98 x 1.77 in)

54 x 32 x 45 mm
(2.13 x1.26 x 1.77 in)

Weight

204 g. (7.2 0z.) with cable

190 g. (6.7 0z.) with cable

Material

ZAMA

Aluminium alloy

SOFTWARE FEATURES

Readable Code Symbologies

1-D and stacked

2-D

POSTAL

e PDF417 Standard and Micro PDF417
e Code 128 (GS1-128)
e Code 39 (Standard and Full ASCII)
e Code 32
e MSI
e Standard 2 of 5
e Matrix 2 of 5
o Interleaved 2 of 5
e Codabar
e Code 93
e Pharmacode
e EAN-8/13 - UPC-A/E
(including Addon 2 and Addon 5)
e GS1 DataBar Family
e Composite Symbologies

¢ Data Matrix ECC 200
(Standard, GS1 and Direct Marking)

e QR Code
(Standard and Direct Marking)

e Micro QR Code
e MAXICODE
e Aztec Code

e Australia Post

¢ Royal Mail 4 State Customer
e Kix Code

e Japan Post

e PLANET

e POSTNET

e POSTNET (+BB)

o Intelligent Mail

e Swedish Post

Operating Mode

ONE SHOT, CONTINUOUS, PHASE MODE

Configuration Methods

X-PRESS™ Human Machine Interface

Windows-based SW (VisiSet™) via serial, Ethernet or USB link
Serial Host Mode Programming sequences

Parameter Storage

Permanent memory (Flash)

CODE QUALITY METRICS

Standard

Supported Symbologies

ISO/IEC 16022
ISO/IEC 18004
ISO/IEC 15415
ISO/IEC 15416
AS9132A
AIM DPM

Data Matrix ECC 200
QR Code
Data Matrix ECC 200, QR Code

Code 128, Code 39, Interleaved 2 of 5, Codabar, Code 93, EAN-8/13, UPC-A/E

Data Matrix ECC 200
Data Matrix ECC 200, QR Code

USER INTERFACE

LED Indicators

Power, Ready, Good, Trigger, Com, Status, (Ethernet Network), (Green Spot)

Other

Keypad Button (configurable via VisiSet™); Beeper
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A ALTERNATIVE CONNECTIONS

POWER COM AND I/O CONNECTOR

The Matrix 210™ reader is equipped with a 25-pin male D-sub connector for connection to
the power supply, serial interfaces and input/output signals. The details of the connector pins
are indicated in the following table:

1 13
ee 000000000 00
e e 0000000000
14 25

Figure 88 - 25-pin Male D-sub Connector

Power, COM and I/O Connector Pinout
Pin Name Function
13,9 Vdc Power supply input voltage +
25,7 GND Power supply input voltage -
1 CHASSIS Cable shield connected to chassis
18 1A External Trigger A (polarity insensitive)
19 11B External Trigger B (polarity insensitive)
6 I2A Input 2 A (polarity insensitive)
10 12B Input 2 B (polarity insensitive)
8 O1l+ Output 1 +
22 O1- Output 1 -
11 02+ Output 2 +
12 02- Output 2 -
20 RX Auxiliary RS232 RX
21 TX Auxiliary RS232 TX
23 ID+ ID-NET™ network +
24 ID- ID-NET™ network -
14, 15, 16, 17 |NC Not Connected
. RS485 RS485
Pin Name RS232 Full-Duplex Half-Duplex
2 X TX+ RTX+
3 MAIN INTERFACE RX *RX+
4 (SW SELECTABLE) RTS TX- RTX-
5 CTS *RX-

* Do not leave floating, see par. 4.2.2 for connection details.

In order to meet EMC requirements:
e connect the reader chassis to the plant earth ground by means of a flat copper braid
shorter than 100 mm;

o for direct connections, connect the main interface cable shield to pin 1 of the 25-pin
connector.
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ON-BOARD ETHERNET CONNECTOR

In Matrix 210 2xx-x1x models, an M12 D-Coded connector is provided for the on-board
Ethernet connection. This interface is IEEE 802.3 10 BaseT and IEEE 802.3u 100 BaseTx

compliant.
1 "‘Q 2
4 I 3
Figure 89 - M12 D-Coded Female Ethernet Network Connector
On-Board Ethernet Network Connector Pinout
Pin Name Function

1 TX + Transmitted data (+)

2 RX + Received data (+)

3 TX - Transmitted data (-)

4 RX - Received data (-)

ID-NET™ NETWORK TERMINATION

The network must be properly terminated by a 120 Ohm resistor at the first and last reader of

the network.

INPUTS

There are two opto-coupled polarity insensitive inputs available on the 25-pin connector of
the reader: Input 1 (External Trigger) and Input 2, a generic input. See par. 4.5 for more

details.

The electrical features of both inputs are:

Vag = 30 Vdc max.

IIin = 10 mA max.

The relative pins on the 25-pin connector are:

Pin |Name Function
9 Vdc Power Supply input voltage +
18 |I1A External Trigger A (polarity insensitive)
19 |I1B External Trigger B (polarity insensitive)
6 I12A Input 2 A (polarity insensitive)
10 |I12B Input 2 B (polarity insensitive)
7 GND Power Supply input voltage -
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OUTPUTS

Two opto-coupled general purpose outputs are available on the 25-pin connector. See par.
4.6 for more details.

The pinout is the following:

Pin |Name Function

9 Vdc Power Supply input voltage +

8 01+ Configurable digital output 1 - positive pin
22 |01- Configurable digital output 1 - negative pin
11 |02+ Configurable digital output 2 - positive pin
12 | 02- Configurable digital output 2 - negative pin
7 GND Power Supply input voltage -

The electrical features of the two outputs are the following:

Vout (ILoad = 0 mA) max = 30 Vdc.
Vout (ILoad = 10 mA) max = 1.8 Vdc
lLoad Max = 40 mA continuous; 130 mA pulsed

Ppo = Vout X lLoag max = 170 mW

The output signals are fully programmable being determined by the configured
Activation/Deactivation events, Deactivation Timeout or a combination of the two. Refer to
the Digital I/O folder in the VisiSet™ Help On Line for further details.

Matrix 210™ —
Ext. V+
O+ 811 f
LOAD
} - K:_ 22/12
O-
Ext. V-

Figure 90 — Isolated Current Sinking Output Connection

Matrix 210™ —
Ext. V+
O+ 8/11
- 22/12
j 04__4: LOAD
Ext. V-

Figure 91 — Isolated Current Sourcing Output Connection
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Matrix 210™

Vdc
+ 8/11
O
} - ﬁ,_ 22/12
O_

GND
_ 1

Figure 92 — Non-Isolated Current Sinking Output Connection

Matrix 210™

Figure 93 — Non-Isolated Current Sourcing Output Connection
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USER INTERFACE - SERIAL HOST

RS232 PC-side connections
1 5 1 13
m \oooooooooooooj
00000 ccccce
9-pin male connector 25-pin male connector
Pin Name Pin Name
2 RX 3 RX
3 X 2 X
5 GND I GND
7 RTS 4 RTS
8 CTS 5 CTS

How To Build A Simple Interface Test Cable:

The following wiring diagram shows a simple test cable including power, external (push-
button) trigger and PC RS232 COM port connections.

25-pin D-sub male 9-pin D-sub female
21 TX / N\ D\ 2 ey
20 _Rx [ 1a], map ~c
7_GND /5 GND
N\ 4
25 GND

Matrix 210™ « 13 Vdc

18 11A

T 19 11B |

“] Power Supply

Power GND
Vdc (10 - 30 Vdc)

Test Cable for Matrix 210™

Figure 94- Test Cable for Matrix 210™
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GLOSSARY

AIM
(Association for Automatic Identification and Mobility): AIM Global is the international trade
association representing automatic identification and mobility technology solution providers.

AIM DPM Quality Guideline

Standard applicable to the symbol quality assessment of direct part marking (DPM)
performed in using two-dimensional bar code symbols. It defines modifications to the
measurement and grading of several symbol quality parameters.

AS9132
Standard defining uniform quality and technical requirements for direct part marking (DPM)
using Data Matrix symbologies.

Barcodes (1D Codes)

A pattern of variable-width bars and spaces which represents numeric or alphanumeric data
in machine-readable form. The general format of a barcode symbol consists of a leading
margin, start character, data or message character, check character (if any), stop character,
and trailing margin. Within this framework, each recognizable symbology uses its own unique
format.

BIOS
Basic Input Output System. A collection of ROM-based code with a standard API used to
interface with standard PC hardware.

Bit

Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits
compose one byte of data. The pattern of 0 and 1 values within the byte determines its
meaning.

Bits per Second (bps)
Number of bits transmitted or received per second.

Byte

On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to
represent a specific character or numeric value. Bits are numbered from the right, O through
7, with bit 0 the low-order bit. One byte in memory can be used to store one ASCII character.

Composite Symbologies
Consist of a linear component, which encodes the item's primary data, and an adjacent 2D
composite component, which encodes supplementary data to the linear component.

Dark Field Illumination
Lighting of surfaces at low angles used to avoid direct reflection of the light in the reader’s
lens.

Decode
To recognize a barcode symbology (e.g., Codabar, Code 128, Code 3 of 9, UPC/EAN, etc.)
and analyze the content of the barcode scanned.
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Depth of Field
The difference between the minimum and the maximum distance of the object in the field of
view that appears to be in focus.

Diffused Illumination
Distributed soft lighting from a wide variety of angles used to eliminate shadows and direct
reflection effects from highly reflective surfaces.

Direct Part Mark (DPM)
A symbol marked on an object using specific techniques like dot peening, laser etching,
chemical etching, etc.

EEPROM
Electrically Erasable Programmable Read-Only Memory. An on-board non-volatile memory
chip.

Element
The basic unit of data encoding in a 1D or 2D symbol. A single bar, space, cell, dot.

Exposure Time
For digital cameras based on image sensors equipped with an electronic shutter, it defines
the time during which the image will be exposed to the sensor to be acquired.

Flash
Non-volatile memory for storing application and configuration files.

Host

A computer that serves other terminals in a network, providing services such as network
control, database access, special programs, supervisory programs, or programming
languages.

Image Processing
Any form of information processing for which the input is an image and the output is for
instance a set of features of the image.

Image Resolution
The number of rows and columns of pixels in an image. The total number of pixels of an
image sensor.

Image Sensor
Device converting a visual image to an electric signal. It is usually an array of CCD (Charge
Coupled Devices) or CMOS (Complementary Metal Oxide Semiconductor) pixel sensors.

IEC
(International Electrotechnical Commission): Global organization that publishes international
standards for electrical, electronic, and other technologies.

IP Address

The terminal’'s network address. Networks use IP addresses to determine where to send
data that is being transmitted over a network. An IP address is a 32-bit number referred to as
a series of 8-bit numbers in decimal dot notation (e.g., 130.24.34.03). The highest 8-bit
number you can use is 254.
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ISO
(International Organization for Standardization): A network of the national standards
institutes of several countries producing world-wide industrial and commercial standards.

LED (Light Emitting Diode)
A low power electronic light source commonly used as an indicator light. It uses less power
than an incandescent light bulb but more than a Liquid Crystal Display (LCD).

LED llluminator
LED technology used as an extended lighting source in which extra optics added to the chip
allow it to emit a complex radiated light pattern.

Matrix Symbologies (2D Codes)

An arrangement of regular polygon shaped cells where the center-to-center distance of
adjacent elements is uniform. Matrix symbols may include recognition patterns which do not
follow the same rules as the other elements within the symbol.

Multidrop
A communication protocol for connecting two or more readers in a network with a
concentrator (or controller) and characterized by the use of individual device addresses.

Multi-row (or Stacked) Symbologies
Symbologies where a long symbol is broken into sections and stacked one upon another
similar to sentences in a paragraph.

RAM
Random Access Memory. Data in RAM can be accessed in random order, and quickly
written and read.

Symbol Verification
The act of processing a code to determine whether or not it meets specific requirements.

Transmission Control Protocol/Internet Protocol (TCP/IP)

A suite of standard network protocols that were originally used in UNIX environments but are
now used in many others. The TCP governs sequenced data; the IP governs packet
forwarding. TCP/IP is the primary protocol that defines the Internet.
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